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RA, o] AAHE BIEX YBA7E ofj2le B BT o] £4F 9n
BIEX o] 2RQIA olsfslar glow 1 7|2 e e g ek 7Hys
217 5he 22 MK B 0.2 9= ZRAN thil A8k Wil

= T2 MM E 5T WYSIWYG QI Ejd| o] A wj&ofl KX E T} 4] 202 Hlct,
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EYSHE 2 HAEE HE ARRE B2 2UA & Aol

KIEX 2 5 & thetoloh (w2 171% 25t igkolth). T2fLt WYSIWYGO] o4&
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a2zt ojuhF Y= ZEAA Hl% =
Aolth, Y= T2AM ALGH S Sm Qg u) Toh e Hke Eququ 28 4 gl
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T2fA] o] QA AT ol AL Hlire] FEI FELS tSATE
oln] o] 7] 22l KXol thet 214l & HAI 2 Sk, whok 13X ek ghigh 24l

Ajebel The B4 Foll A shuhe WA gol 2 g At

« The (Not So) Short Introduction to EJjX2e ' =51 235t st=20f Hiejo| st
) . FETEX 26 Y&2J. TeX Live2F MiKTeXOfl
e Learn LaTeX in 30 minutes Ttz QOB 2 texdoc lshort-ko

EEENCEIER-PNIE

oco=

« https://en.wikibooks.org/wiki/LaTeX/

o] QHAfol AL o] Zhike] Y TRAME S T oliret vl P S el 2
A B0 o]o] T g3te] 22 A BH= BT WAl FobE ol
11 A A4
Yo ZRAA 715 4 PR ot sd 4 Atk 12T AR E BEX 3
7

(commands) 0.2 F@s}aL of® AL 3722 *}Q“OHOF ek gi7) A2k A2 BEX
= st Mz ma?—} B& AFste w3z 2goltt. £E2 g7]A 50| U
FLe A= 2A o J=Al, FE DS ob=Al, 2ol of GA| AXE 4= Ql=7A] Fofof
Sttt Zlojh. ojj 7| Ao EHOHH% 1.1.38oj| A HZ g},

mfj 7] 2| e} 28k TpX B A5 52 Comprehensive TeX Archive Network (CTAN)
ojgh= HEY Ao LS 4= At 1 A& https://www. ctan.orgo|T.

o|% CTAN:o|2t1l ®7]g 212 A5t CTAN vl2le] X t e gjets on 2
AF2-51ZTh, oAt CTAN://latex4wpehil E@ASH 212 https://mirror.ctan.org/
pkg/latex4wpel sliigetet,

4

£ "2 E ot E7} a5ttt ASAHE:
pol| 2 = BIEX 'Eéfzmé%ﬁ (IDE)°| & B3 4% Q)1 o] 2L KIEX A2 ZH4o] Eatg
olHE E 7t 7] B2 &Y njgEy|et 2 Ho| e 5 AAskal )l
ofgf] &75h= ol E Foll sht& AT 25 AH{/LEAL AT ELofo|t},
« TeXstudio (E]Z3E; GNU/Linux Applmage 2} Windows-§ portable app ©]-&
7Fs): https://www.texstudio.org



https://www.ctan.org/tex-archive/info/lshort/
https://github.com/KoreanTUG/lshort-ko
https://www.overleaf.com/learn/latex/Learn_LaTeX_in_30_minutes
https://en.wikibooks.org/wiki/LaTeX/
https://www.ctan.org
https://www.ctan.org
https://mirror.ctan.org/pkg/latex4wp
https://mirror.ctan.org/pkg/latex4wp
https://mirror.ctan.org/pkg/latex4wp
https://www.texstudio.org

« TeXworks (BE]Z21E; GNU/Linux Applmage -%):
https://tug.org/texworks/ (TeX Liveol ZgH

+ Texmaker (HE]ZSHE): https://www.xmlmath.net/texmaker/index.html

« TeXShop (Mac OS X): https://www.uoregon.edu/koch/texshop/

« TeXnicCenter (Windows):

https://www.texniccenter.org/

e A BIEX &-8-2 G4t 2352 pdflatex == xelatex, lualatex 2=
d7dsh= PDFoltt. mixt7ix| = J12f 9 23sh7] &= B o]/d PosTscripTU EPSE 1125}
ok}

1o .

1.1.1 oA Bo]7]o| Bs}od

o] #A] M| & 53t CTAN://latexdemo 7] 2|7} Al &5k v BIEX 2= 22t 1 &
Hg Hole 7|5 &85t o|uZ latexdemo”}t 2 F25HA] &2 wf ol CTAN://

example T 7| X & A 27} 2F 4 5ho] 283k 3ol k.2 S5 st=of g =ol|A s 229 ol
H0|7|& W2X| %1 (tcolorboxE
0|st) HEo| $AS Bt

1.1.2 °gE7} A Y3t 75 gasteirt.

X2 27| ol aAo] Zepu)z] £o]7], 7] vHt7] 52 oltj g7} s ofof
Sttt & 12 AFE A27Fs AbolollA |73t ot E| GNU emacs, vim} jed9] 2
£ 99 7ot} jed= S IDE 7| HIJIG 2.2 A A5H3ITh

1.1.3 7| A] F7}517]

ofgf 42 tF22] GNU/Linuxoll Z &= o] l+= TeX A|ARIRI TeX Liveol 4-&€ .
MacTeXoll M= & &g Z oA WA= Linuxol o 943ttt 74 8935 Windows
QI MiKTeX2 8t 2|42 w2 Z o] FZirt.

o9 w2 BIpX T 7] 2|7} 7| 24 0 2 Alg-Hrt. ol & £ dH|Qt 7|¥ke] GNU/Linux
Hj 252 texlive-* 2= 0] 59 B2 7| A& 23 (o714 s 7] A2k g A2
A0 2 KIEX m7] 2| et 5517 F= 5 S},

2 UH A
Mg ™ est glokel ohe WAE et

$ mkdir -p ~/texmf/tex/latex

o] Tielele] ozl A} W] 2| & A|ate.

2. 71742 CTAN 0]2i 23 174 2 e R =3k}, tjl2 zipo e 4 rj2ge)
o1 Fo]t. 0| 2S foo.zipolet B2 s},

3. 4% 93] A& B},

$ mkdir ~/texmf/tex/latex/foo
$ mv foo.zip ~/texmf/tex/latex/foo

$ cd ~/texmf/tex/latex/foo ; unzip foo.zip



https://tug.org/texworks/
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https://mirror.ctan.org/pkg/latexdemo
https://mirror.ctan.org/pkg/example
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https://mirror.tug.org/texlive
https://mirror.tug.org/mactex/
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kil Emacs Vim Jed
Hyg nc Alt-X ESC Alt-X
A rE n/a iao0 n/a
i R n/a : n/a
e 2%
o 7] Ctrl-X Ctrl- e Ctrl-KE
o Al Ctri-Xi 'r Ctrl-KR
ol A% Ctrl-X Ctrl-S ‘W Ctrl-KD
Molgoz Ctrl-X Ctrl-W name W name Ctrl-KS
o &) Ctrl-XK :q Ctrl-KQ
H 3 H7 Ctrl-XB bN Ctrl-KN
%] 4 (undo) Ctri-xu u Ctrl-u
AL (redo) Cctri-" Ctrl-R Ctrl-G Ctrl-U
E47] Ctrl-X Ctrl-C :qa! Ctrl-KX
1A o] &
St thof 21 Alt-B b Ctrl-A
Stdo] o2& Alt-F W Ctrl-F
Px]goZ Ctrl-A 0 Ctrl-Qs
gooz Ctrl-E $ Ctrl-QD
ShHo]r] ko2 Alt-V Ctrl-u Ctrl-R
StEo|x] HE Ctrl-v Ctrl-D ctrl-C
H 1 o] TS Alt-< 1G Ctrl-QrR
H 1 o] ghE Alt-> G Ctrl-QC
A A5t sjoz Alt-G n. n.G Ctr1-qQI
AEAjI517]
AZ 3+ 22 Ctrl-H X BS
REZ S ZA} Ctrl-D X Alt-G
AZ 5k ol Alt-DEL db Alt-BS
LE2Z 5l o] Alt-D dw Ctrl-T
ZL7HA| Ctrl-K ds$ Ctrl-QY
Az Ctrl-A Ctrl-K dd ctri-y
7] & HFE]
27| Ctrl-S text /text Ctrl-Qs
Zrotutat 7] Alt-% :s/old/new/g Ctrl-QA
HEG Y
AEd A ZE Ctrl-SPACE v Ctrl-KB
Zrety 7] Ctri-w D Ctrl-KY
EAFsH| Alt-w Y Ctrl-KH
20497 ctrl-Y P Ctrl-KC
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4. THoF sty mkdo] Ex5}] k=t latex foo.ins?t latex foo.dtx HHS
AgYsto] 17 Zojujolof gt
5. thS RS Asgsitt.

$ texhash ~/texmf

MiIKTgX oA 117] 2] & Z7}5t ™ 4 MiKTiEX consoleo] U Ha 8 S o]-&

\latex\newpackage tZE|2]= C:\localtexmf\tex\ o}2o] FH=11 %&?}
A 7)ol ZhAtHE. ol At AAE mE thg MiKTeX Options &
‘Refresh now’ HHES 20} T= initexmf -u HHS HH oA A3ystct, 017/1
AR

ot 1} 7] 2] 7} A 2] E S0l = \documentclass A o]Sof o} S =0 24 2}Al
o] FAjol Zgg 4 et

rol
&

[ru
ruz
:l:’.
ot
o

\usepackage{foo}

1.1.4 Info H|o]A] 7}

‘man’#} ‘info’ B0 X = AZEQolo] dXY EAE “534‘ MIOI/“E Agsk= Aoz
UnNix4 GNU/Linux A AElo| A &3] AF&-E= Zlo|tt. gkef latex2e.info &A47F A
x| &]of QA o b3} o] stz
1 oS oz ERt
https://tug.ctan.org/info/latex2e-help-texinfo/latex2e.info;

$ gzip latex2e.info

$ sudo cp latex2e.info.gz /usr/share/info/

$ sudo ginstall-info latex2e.info dir

oAl info latex2e HHPLO & info ZAS A& 4 r}.
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(535474 9] Unix TeX Live Al AE0f|A
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stete|of QIot, w2t EE 2 texhashlt
mktexlsr2 AESHX| QIOFE EICH A|AH
22| X2 M TEXMFLOCAL 2| %[0l 2
IH7| X2 AX[HE mof= o] A Aldo|
ZQstCt,
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https://tug.ctan.org/info/latex2e-help-texinfo/latex2e.info
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o| ol &
File[>Save(#]

File ¥+

st FE dRE BEKI FEsich oS
45171), File[>Close(27]) 52 ot E{ 2] 7] 50l

2.1 File>New(A T+¥)

]:_Hl:ll:lo

mo]A] st} RhE FE s oha) 2,

£ File>Open(@d &7])

9= mR Aol A o] w32 Mt ¥l Hol 7] slutE HolETh, KXo 2 ¥l

\documentclass{article}
\thispagestyle{empty} % Lf|0|Z| HHS A|A

\begin{document}
% 0] HE2 =AM (comment). 27} MELCt.
\end{document}

EEX 22 2439t 4= 284 o Aot} 23 ¢

AEA R A E HA}

\documentclass[adpaper,12pt]{article}
\begin{document}

\title{My Document}

\author{John Smith}

\date{London, \today}

\maketitle

\begin{abstract}

This is a very short article.
\end{abstract}

\tableofcontents

\listoftables

\listoffigures

\section{First Section}
\label{sec:start}

This is the text of the section.
\section{End}

\label{sec:end}

This is the end of the document.
\ref{sec:start} to read it again.
\begin{thebibliography}{99}
\bibitem{Gonzato} Gonzato G. \textit{\LaTeX{} for Word Processor
Users}. CTAN, 2001--2023.

\end{thebibliography}

\end{document}

See \cite{Gonzato} for details.

Please go to Section

R2o) Adol o e 24 WS

2lo] neig]o] 9t

2.2 File[>Save As...(tt2 J2]o 2 %)

BIEX

248 e Zoo g wgksl A & o) A-88 4 Qe Aol
« TpX4ht+ BIEXS HTML/XMLE #HEs517] 99
https://tug.org/tex4ht

[
Al
=

HFTeX Liveofl & Iwarp2hs TH7| X &

HE 2 It

FILE 0|5+


https://tug.org/tex4ht

« HTMLZ H&5}7] 98] latex2htmlS o] &5 &% 9]},
CTAN://latex2html

« latex2rtf= RTF (Rich Text Format) 2 W&ttt
CTAN://latex2rtf

N

o detex (B3 HE7|)= BIEX Bl 15 At Sl HAEZ WH3s|E
https://github.com/pkubowicz/opendetex,
CTAN://detex/

283 Pandocolghe 2 1340] it} o] Z2 T3] thal Al Wz e] 8 g Fofsto]
ATt 2482 9ol iy] Hhzitt. PDF A} )2 27)o] that AFgHe 2648 Hef.

2.3 File[>Save As Template(1Z3 22 %)

BpX ‘§lE30lgt= o] M2 BpX H7|A & e A ou|gittH, o] QhufjA{ 7}
2= QS dolA= B3t EAlolth.

2.4 File>Import(E°127])

Pandoc ZH|°]A] https://pandoc.orgol the} Z-& uj-&o] it}
o3 Zejo] utdS o}= xujo 2 HEksly st pandocol s E;L*(v]’ (S5 eleny 7ho| 4 2t (swiss army knife)
=t

Pandoc—l 7]E E -2 Markdown 7o}, o] Zujo 2 HE KXo 20| HEh2
A o] FolXt}. ol & S| EA}. thgol Hol= A2 Markdown 2 2 2Hd 3t ZA{o|t},

title: |

This is the title: \

now write the rest
author: Guido Gonzato
date: August 2023
abstract: |

This is the abstract.
<!--- This is a comment. -->
[comment]: # (This too is a comment)
# Section
This is **bold text**, this is *emphasized text*, this is normal text.
If you're bored, go to [The End].

## Subsection

This is “verbatim text'.

6 FILE M|+


https://www.ctan.org/pkg/latex2html
https://www.ctan.org/pkg/latex2rtf
https://github.com/pkubowicz/opendetex
https://www.ctan.org/pkg/detex
https://pandoc.org
https://en.wikipedia.org/wiki/Markdown

# The End

My dad used to say:

> Damn, Pandoc has not been invented yet!
but not it has.

<l--- end of pandoc_ template.md -->

o] A& At 7}535t KX AA R v oS 8-S Yo

pandoc -s pandoc_template.md -o pandoc_template.tex

EEXS AA o] AAE A% PDFE st ¥ oh3 B2 Wt

pandoc --toc \

-V urlcolor=blue -V toccolor=red \

-V geometry:margin=2cm \
pandoc_template.md -o pandoc template.pdf

-V B2 AJAbsh= = = A s =
Pmmmal%ﬂ%q%iiaﬂ%N%mm%giﬂi§¢%ﬁh§7ﬁhﬂ

Sojmzt,

$ pandoc -s index.html -o index.tex
$ pandoc -s text.docx -o text.tex

$ pandoc -s text2.rtf -o text2.tex

..and so on.

-5 S 71+= “standalone” ] ju|o|tt. = & upl 2 A BIEX &4 7F "l thes 5ol

Markdownol| A #2413} k=2
o] &4-2 A7} 7ttt} Markdownolli= of2] ®1&E0] QUL ZtA} A|g6t= 750l ZF4
o2}, 428H4 9] 2] Yol ZF Markdown AFFrtCh 2F7F x}o] 7} Ql=H, pandoc Markdown
£ 7|20 R 4842 th-3 3} o] A 2lgitt.

+ WS (in-line) +A2 ,$= AlAetA §, 2 BdTh

o] Aot}

. H3(displayed) 212 $¢$ 1} 3¢ 3 Alojol] Hojd=

F A9 2ol ¢,9F Zo] Mo AR Frof sttt 7 wF ol ghato] B4 /ol A 2zF
Z2hS A e, gho]9] A dhdo] o]oj27] wjgo|t}. EE5olstA RAMS

YZF A E P_EJPEOPOF FHohs 2A7F Uk

oF 25

o2
ol

5 249

i

237

o
uy
=
)
-
=5
Q.
o
g
=]
gl
R
it
2L
ox
gt
2
IN T
1o,
gt
)
rlo
~
S
v3)
b
£
N
)
i
fu
3t
[e]
ol
X
[e]
ol
I
A,
o,
o

title: A=

author: A At
header-includes: |

k E

ok O

[=)
S

FT A2 Markdown 2] 7P%E|

FLERI Multimarkdown = \\(Qf
i3S A AR S X SH| o
AME

\\) F0i| ST = 210

2.4 FILEDIMPORT(E0{27])

A\
20
7

2t=

\
tsotct.



|2 A7), A4 B, oS At Luka gy
2 =L Aolc} 84 I7)=
executivepaper 59 stU= x| Hstct, B3k

Hofstol 127t ) §A17 HES 2 4 Q). oS 59 ket 2k,

\usepackage{kotex}

Tk XgiTEX #Hutd o] & 25ttt Pandoc A998 off Th-23 20| - -pdf-engine

248 Fofof i},

$ pandoc --pdf-engine=xelatex -s -t latex mywork.md -o mywork.tex

55 Bo| 32 Markdown 2A4E 43h1 Hejshs 4EL Bt

File[>Page Setup(Zl°] 2] A 4)

© \documentclassoil &4 u}z}u| g
adpaper, aSpaper, b5paper, letterpaper, legalpaper,
F2 portrait”7} 7] 2214, landscape&

\documentclass[a5paper, landscape,12pt]{article}

B4 AAofl 2z ufi e \setlength o2 A3}, o] g2

et 7H2E 2
ZS vk off AHg-ShE Zlolth® geometry T7| A & o] &3 Zlo] o] £t o] 72 E
o|- &5t & Ato]=, mpl Zojet 22 mEtn|E S5 &#45| Ao 4= 9l
o= v B2 AEALRo] JlojA of7]of o AT 4= itk H7|A] 24 E ¢
dgtet. o ool A3 AHERIE o HYled R vetnEE e S &
ol 2ol doH, 9] g 57] 93 B9 A= Qi

ot

\usepackage{geometry} % top of document

\geometry{paperwidth=25cm}
\geometry{paperheight=35cm}

% or: \geometry{papersize={25cm,35cm}}
\geometry{width=20cm} % total width
\geometry{heigth=30cm} % total heigth

% or: \geometry{total={20cm,30cm}}
\geometry{textwidth=18cm} % width - marginpar
\geometry{textheight=25cm} % heigth - header - footer
% or: \geometry{body={18cm,25cm}}

\geometry{left=3cm} % left margin
\geometry{right=1.5cm} % right margin

% or: \geometry{hmargin={3cm,1.5cm}}
\geometry{top=2cm} % top margin
\geometry{bottom=3cm} % bottom margin

% or: \geometry{vmargin={2cm,3cm}}
\geometry{marginparwidth=2cm}
\geometry{head=1cm} % header space

\geometry B35 Al th24 ¥ w72 34 S F=HH e ot

\usepackage[left=3cm, right=2cm]{geometry}

(555l o 2 A9 I‘Rf._ counter 2} dimension
2 YA 2G| b, mi2ti|e HEE
Ui “IH2E{" 2t XA St QULE 0

| HUEE IHZE 7|5, 0|22

2= FH2E{0f CHSi A 2t FHRE{2t D
= a2tol| et HASHALE

#%)memoir/oblivoir®| A1 = geometry
oF= CHE YAl9| SafA XhA| H|OfX|
flojor2 &7 YOl UCE oblivoir 7t
M| S SH= fapapersize I 7| X| & ZHHSHA| &
&= UCE 7 |X| 2ME & 1052} geometry
7t memoir/oblivoirOlA 58 YO 7|X|=
o=
H4Ea

u}

o2 AP X QOLt ZeiA XN 2X|
FSAIO AFE S = giCt

FILE M|+


https://www.ctan.org/pkg/geometry

2.5.1 Page Setup[>Headers and Footers(}}slc HF)
fancyhdr H7| A & AL&-5}H \pagestyle{fancy}at= HH 2 & 4 JA Hoh. 0 24
o] /ctof] @A A — book.clsztH & (chapter) — & L& F= FTHF} s5tdhof Ho] %]
MO S Uetd s stdHF5 Al o mefo g vhaol &, sttt |5 ARgAe sk
A& 7hsstth. ZF 3 oS 9%, 7hetl, LEZ Al 2oz /st 2 f2ol
A% AY Jhed Y, Q2% HPo| 247 &Y} thg B 5 Hat !

\usepackage{fancyhdr}

\lhead{} % empty

\chead{Hello, world!'}

\rhead{Page \thepage} % page number

\lfoot{}

\cfoot{\textbf{Hello!}}

\rfoot{}
2.6 File[>Print Preview (&3 njg|17])
U Eu st pdflatex =+ xelatex, lualatex 2 PDF TS HEE THE-0]A] 24 0]
&7 2= PDF 1|2 7] & A3gshH .

hyperrefoltt url 22 m7]21& 2H Ha2te Q7155 PDF 5t ghETh ofof of o
SiAE 41842 Eeh 22 pdflatexoll A 27 7|2 & AHEE o] 415 S ¢

e, ? o] ok T zpAIRH AML 4.14 o)A ThR T

2.7 File>Print(Q4})

At4lo] AH8-5Fa QL= PDF vl 2] B 7] 4 9] wl4xol File[>Print &50°] 31-& Zo|ct.

2.8 File[>Versions(H{A &)

W7 olg] Walel TE 2L o5t me o]

AFE 271 RCSE2 B AgA B8 FoHd 4
Z AFEAFS A Q5= Subversion, Git, Mercurial Z+-2 =17} ‘3 st G1t°] 7 ]’ S

AHEEE ARl BIpX 5§ wejol BaljA & oha 2415 Farstet.

o https://www.desy.de/~bargheer/gitintro/git.html

(5% memoir/oblivoirOil A = fancyhdr
oF= CHE Y419 222 XHA| ‘H 0| x|
2B M &A10] AL fancyhdret
SEE YOIX|= gb= A2 LN
ACLE SEHA Q| HF LA SA0| ArES
= gioh

= o) o Hlof A M sHe B0 OlAlE
OiIT fancyheading 2| Z30|C}, X<
fancyhdr= O BE2 X @57 |= SHX| 2t

=2 \fancyhead, \ fancyfoot
m o2 MEBHE 710 =0t £3| o

Z2ME CIXfQlEt mjof] T 2{stCt, "

ooz 04If f ﬁﬁfﬁ, EPS =
OJEE.OE pdflatexOll A & &
AT Ol TeX Live A|AEIS A
OOt EPs O S PDFE 25
P BN ﬂfmol &2t o] U

ol u9
ey
N
10
s

oF
el

« https://www.math.cmu.edu/~gautam/sj/blog/20130929-git-quickstart.

html

3 Editd¥%

o] wl ol sgsh= AFF2 BIEX Q] 7]-5-0] otz w3 7|9t el e Zlo] gt WA & 10
A, Zet7] - EAlst7) - 2ol 7] - 2 7] - Zhobubat 7] (Edit[>Cut, EditD>Copy, Edit[>Paste,
Edit[>Find, Edit[>Replace) 5l sidst= 2 71A] ot B 9] 7]HlRld S 4w e},

2.6 FILED>PRINT PREVIEW(Z3 0|2|27])


https://www.ctan.org/fancyhdr
https://www.ctan.org/pkg/hyperref
https://www.ctan.org/pkg/url
https://www.desy.de/~bargheer/gitintro/git.html
https://www.math.cmu.edu/~gautam/sj/blog/20130929-git-quickstart.html
https://www.math.cmu.edu/~gautam/sj/blog/20130929-git-quickstart.html

A2 2oL 517] el Mol7|E siA T Ar o] 54 Aetdle A gateln
giE2 Heg it ek BEXOIA olo] slgshe AHe FBER Selu) 87
ool i Zolth, oS ST AR HAE] Fe FA £ Rolstein ok oA F o
7H o 2 gk,

this is \textbf{bold text;}\\

this is .also this is bold text;

i;g;ji;é:e?_zl:}te“ PN this is also bold text;

this is bold text, too! this is bold text, too!

\end{bfseries}

3.1 EditD>Autotext(AHs2A)

o} 7| A x}Eek4ole} st 71 oAt ‘PS’Ebil Eto] W5l ‘PostScript’ 8t AHE 0 &
Fgsto] YT = Ae Dt AHE7Eold A siE Tk BIEXellA ool sigste
AL tiek ok 22 2ol

\newcommand{\PS}{\textsc{PostScript}}

o] ZA| o] gt th-Sof \PSet 5= -2 \textsc{PostScript}etil YHsh= 2t
2t} thaEar o] a5ttt
4 Insert ¥

4.1 Insert[>Breaks(JA}ES)

+ o] Lhiro}x|%) b BUBAE ~ (Lo 2 HHT)

j=={e]

-

o A 8 U=7]= \1inebreakt \newlines &t} E9] xjo|&= oz BV & K}, I HAH= \\ 2 \parof 53| YT

[HF13 ‘

- Ao A8t oLt Axte 23 A

E=VN\2A Y YR 2T et ol =8 4 & 3He2 & 4 AoH(d: f; 25HR| Q47| [[H_A:(H\ o|st=o2 SZCH
k $HE \\= HREN|HE (242 5 4 U
lcm]). ™ M=

WI 1) \newlinedt 72| ZX|2t i (array,
- ing S)0IA= S X1 3 (row) 2
- 2L BT ARSI W 22 TG \par WS 2o, S g, /e B Blow

« 207 H0]AZ U= \newpage F=+= \clearpage o] AUct.

\newline®} &2 \linebreak= &z} P& 2717 3ot

!
I am stretched!\linebreak I am stretched!
But I am not.\newline But I am not.
Another line.\\ Another line.

Ok, now you get it. Ok, now you get it.

3t \clearpage”} \newpage®t T H-& Ax| 9x|7H2] BEE o 9= Z2 E(J
oy #) 58 25 2 th3ol #lo]A| & thethe= Zolth. 22 Eo]| tisiA| = 4.
ofA] g gict

10 INSERT Hl



4.2 Insert>Enumerated List(HE&H JI 2

Uy Et(list)oll= 2 1ol A (bullet) & £0°]= <itemize>2t HEE £0|+= <enu-

merate> B70] Itk \item Waol 34 AAE Hojslo] LY Bobko] Bk 2] #F cgescription>2 2 *EHE\OH (B
iEH &:

X2 FOI) HAES &0 MY W49
EfS RHELL

I'-II] o g

7158 the RO 2 vk 4 Ytk

\begln{ltemlée} ) * with an asterisk;
\item[*] with an asterisk;
\item[-] with a dash; - with a dash;
\item[.] with a dot.

\end{itemize} - with a dot.

7k 3 i

Foo] AR s 5 HE (b e RS v e EuE Y2 g AE9
HE 422714 o 7}—3— f(counter)l 2B S A A o5t Zloltt. \labelitemi,
\labelitemii, \labelitemiii, \labelitemivitemize 7] sld5tL, \label-
enumi, \labelenumii, \labelenumiii, \labelenumiv+= enumerate®] 2H8 7}-2E
AEtYo|t},
728 Ao ¥ 2727} ot \arabicS ‘YHP £2}o] 1 \roman< A&} 2o}
ZAHAE EH 82 viiiZ 7)), \Roman2 &2} 20} £2} \alphe} \Alph+= 2zt
sl AEApel dubsl tjExtolck > T1gtkoll \ fnsymbolo|ghe 2= Lt ool tis) [qi ko TeX Tt oblivoirs eH24] 712

. - = A HH S M3ttt 12 F0l= \gana,
A= Yol (1630]A]) A stalct. \pgana, \ogana, \onum \p m 50| O'Ef.
212} 12 20| 12 h, @, ®, (1
\begin{itemize} ks
\renewcommand{\labelitemi}{*} )
\renewcommand{\labelitemii}{-} first level, item 1

\item first level, item 1

\item first level, item 2

\begin{itemize} - second level, item 1
\item second level, item 1
\item second level, item 2

\end{itemize}

\item first level, item 3

\end{itemize}

* first level, item 2

- second level, item 2

* first level, item 3

enumerate 2| AEo] A 20} S2be} o B} Aupsle 2wl kgt 2o

rok
B

\begin{enumerate}
\renewcommand{\labelenumi}
{\Alph{enumi}}
\renewcommand{\labelenumii}
{\roman{enumii}}
\item first level, item 1
\item first level, item 2
\begin{enumerate}
\item second level, item 1
\item second level, item 2
\end{enumerate}

'BIEX Ol 2Jste] ST BE A, , P72 E S 7HA1 A = /1Y

ic)
[>
|m
[§]
o
o
m
rlo

g
[>
]m
r{r
_1\1
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\item first level, item 3
\end{enumerate}
A first level, item 1
B first level, item 2
i second level, item 1
ii second level, item 2

C first level, item 3

k2 W 0 2 enumerate T7] 2| & 2= W o] o} ' <enumerate> 27

01

25 AElS x| AEt

AN
o=2"T A
A olzp2 A5 7t

o2 Uehdth 17 32 oejo] 3 ol gje] glx

= o= :h_o-] _\Er‘]'

39S 24

S Astach Aali17F2d st 222 &
71212 & 4]o] ZtZ+ \Alph, \alph, \Roman, \roman, \arabic
EE 7t H 3

\begin{enumerate}[{Example} I.]
\item First example.
\label{item:first}
\item Second example.
\item Last example.
Go to Item~\ref{item:first}.

Example I. First example.
Example II. Second example.

Example III. Last example. Go

\item Example 6.
\end{enumerate}

to Item I.

\end{enumerate}
5 o2 27 A g vhreE 712 S A olata).
\begin{enumerate}

\setcounter{enumi}{2} 3 ExampleS

\item Example 3.

\item Example 4. 4. Example 4.

\setcounter{enumi}{5}

6. Example 6.

o Ul Roll A LS paralist 7] 21 & AH&-SFH Hot. <in-

I'll throw in a list of items:
\begin{inparaenum}

\item apples,

\item pears, and

\item oranges.
\end{inparaenum}

\begin{inparaenum}
[\itshape a) \upshapel
\item apples, \label{first}
\item pears, and
\item oranges.

The same list can be labelled with letters:

The first item is \ref{first}.

% enumerate TH7 | X| L O Z28t
7|52 N&5t= enumitem I 7| X = QUCH

=ESS b .
B hemoir 221A = enumerate
j7|X9 7|sg Egstu ez HeZ

2Cgr =Tt gltt. oblivoire

7t e, @, 7,00, 9,01), O, @), @

2h= &5 2| XIAIXFE F71st QUL
oblivoir 7} OtL|2}H koTpx 37t THZ| X Q!
dhucs-enumeratelt dhucs-enumitem=
& nstet,

INSERT M|+


https://www.ctan.org/pkg/enumerate
https://www.ctan.org/pkg/paralist

S5 Ea BEX 99 AdS

$ \$ or \textdollar
& \&
% \%

\_or \textunderscore
\{ or \textbraceleft
\} or \textbraceright
$<$ or \textless

$>$ or \textgreater
\textbackslash
\textbar
\textbullet
\textdaggerdbl
\textdagger
\textparagraph
\textsection
\textcopyright
\textasciicircum
\textasciitilde or \~{}
~ $\sim$

® \textregistered

™ \texttrademark

2 \textordfeminine

° \textordmasculine

> @ M ~fAt 0o — -/ N\ |

R

e

=]

2 EFEAE A

A[m
i
rr

\end{inparaenum}

I'll throw in a list of items: 1. apples, 2. pears, and 3. oranges. The same list can
be labelled with letters: a) apples, b) pears, and ¢) oranges. The first item is

a.

o] oA} EXo]l Aal

il
paralisti= O|8lol = Thekst 1.2 8 4 Qo2 T7| 2] BAS o A U}

4.3 Insert[>Special Character(54&4})

BIA, B 7HA] RAHS BIEXOIA S5 0] g Hchs 22 7195kt of BAHSS o
\E 2ol AL 43} BEo|A YstAL obw 54 w22 S AFgstolof ik, E 2%

2 HMH O Z ASCII ZE9F \char § S A= Zo] it} 9 &
Z+ZF\char36 \char38\char94 \char126°]2}1 =35}

ST EHS 224 7|58 Algste M)A E Qloh olE E9 pifont H7| A=
\ding@ \dingfill, \dinglint, \dinglist H&S 2t It} \ding §H 2 EH
F=9] gl (Dingbat) EAHS &=t} \dingfill¥} \dingline2 \fill¥} \lineo°|

5ottt \dinglist 742 A2 FolX Jull FEE F5 H2| 2 ALgot= P AES

B

rr

~Ha

=
=
o

£IHK|2 312 2EE 9l8 ¥ o2

Al

7
N

Rk

4.3 INSERT[>SPECIAL CHARACTER(EL2X})

13

sl oblivoir £4= T{7| X|2! xob-paralist
fX enumerateOfl CHoH A RHE 241

I

t


https://www.ctan.org/pkg/pifont

RHEC)

\begin{dinglist}{43}
\item one
\item two
\item three
\end{dinglist}

I one
I two

= three

-2 1271 9] dingautolist 72 017l Q1 Ato] sliigsl= 9G¥l T =

AR 752 Alse

e Al &sto]

\begin{dingautolist}{172}
\item one
\item two
\item three
\end{dingautolist}

® one
@ two

® three

71% Bab= U grobA of 7] A o} 9133k 4 glrt. 1 tfAl “The Comprehensive BTEX

Symbol List' 2= &A1 5

43.1 |23 715(€)

23 7)5E
Fhs et

\usepackage[gen]{eurosym}

\usepackage[official]{eurosym}
9 BE\euro PP Al L5t

il * off w2t gt [gen] FAS

A

Hhel = W) B 7)) Mol €abs mo
%43

11}

eurosym 7| A| 2 Az}

a4
il
A

=] o™ Aol A EX] o] ‘official euro’ ZFE A
23} 7] 3+ marvosym 7| X ol M = A F-5F=C

4705+ geh. CTAN://comprehensive. '

¥ 4 b, theT 2 5 7HH] AR AL

o @
xR
o mi
c
En]‘
““rlr\'

|57} Q14fs) = mogo) &
B2} 755 d=t)
‘E} \officialeuro

S E
Qlafjgtct. m|E3et '}
o
=

A

p

4711% ofgtof] 4~

=)
rlo
>

7li%%/‘}30}7ﬂ Stk \ELRYZo= €2 JJH“‘%—’F%EP.

4.4 Insert>Formula($5H4])

BEX S 53] 4:4]9) 2] 33o] 9]

(inline mode) — 2 odjH $ Lo 2

I like math: $x”n + y”~n \neq
z”n\ \forall n \neq 2%
is my favourite theorem.

Ilike math: 2" 44" # 2" Vn # 2

is my favourite theorem.

(HF)7eX Live 2 A X|HCHR &2iSol| A]
texdoc symbols == texdoc
comprehensive ‘?5'%42 Liz&Eat

[&4*20] 20319} AIBLE LIEHH S 7|5 W, ¥ S
\textwon, \textyenQZ ¥ 4= QICH

(%721 s msmath TH7| X2
\eqref FHE £+ UL OIS
“Eq.~\ref{eq:fermat}”2t11
\eqrefO = HM Eq. (1) 20|
LIEFCHCE,

2L
o 0fl A

HES
StERES

INSERT M|+


https://www.catn.org/tex-archive/info/symbols/comprehensive
https://www.ctan.org/pkg/eurosym
https://www.ctan.org/pkg/marvosym

Fermat's Last Theorem
defined as:
\begin{equation}

X*n + y*n \neq

z”n\ \forall n \neq 2
\label{eq: fermat}
\end{equation}

Can you prove
Eq.~\ref{eq:fermat}?

is
Fermat’s Last Theorem is defined

as:
2yt £ 2"Vn£2 (1)

Can you prove Eq. 1?

4.5 SymPy AF&H

m2 ey Qlojot AR ENE S 4] Jeio] HE 2HE AL AT SymPyahs Thol 4
£

H
Plolselel g e ot masony
o
=

27} gleh A wel
2 SymPy oj|A|o]t}.
82% Oﬂ °HE6]-°]'E‘ HTEX _1__—‘%‘

_|>~1
0

EIEX 42 22 & 3l mpojdo] 458

In [2]: init session()

types: python)

>>> from sympy import

>>> f, g, h = symbols(
>>> init printing()

In [3]: expr = (x/2 -

In [4]: latex(expr)

Out[5]: "\\frac{x"{3}}
y~ {2} - \\frac{8 y"{3}

In [1]: from sympy import *

IPython console for SymPy 1.9 (Python 3.10.6-64-bit) (ground

These commands were executed:

>>> from  future  import division

>>> X, y, z, t = symbols('x y z t')
>>> k, m, n = symbols('

Documentation can be found at https://www.sympy.org

Outf[4]: "\\left(\\frac{x}{2} - \\frac{2 y}{3}\\right)~{3}"'

In [5]: latex(expr.expand())

*

k mn', integer=True)
'f g h', cls=Function)

2%y/3)**3

{8} - \\frac{x™{2} y}{2} + \\frac{2 x}{3}
27}

ojA| o] A2 RE dojA= 42 ot E 2 BAMS] o9 7|tk & \\& \Z =

7\ st e,
wrof shol Al Qlojo] £
BES AmuE e E0,

St python BIEX 1 7] 2] 2 LaTeX Expression project

4.5 SYMPY AF2H
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https://www.sympy.org
https://www.ctan.org/pkg/python
https://mech.fsv.cvut.cz/~stransky/en/software/latexexpr/

4.6 Insert[>Footnote(Z3

o

N

u: r

[e]}
=

o

'
fol
o
>
N
fol
A
i

_(_)4

lo

\footnote[n]{footnote text}zt=
Ittt \footnote H-S Tojet npH &, £

U:]

o

ar,

Z}3 7152 A2 ™ \footnote 712 EH S

\renewcommand{\thefootnote}%
{read me!}

This footnote\footnote

{I mean this one.}

says it all.

This footnote™ ™ says it all.

d me! .
A4 MET mean this one.

o] ¥

o

ARg 243

7 W5E 2ol | 242 ek

9}1

o},

s
n

\renewcommand{\thefootnote}
{\Roman{footnote}}
This\footnote{The first.}

is the first footnote,

and this\footnote{The second.}
is the second.
\renewcommand{\thefootnote}
{\fnsymbol{footnote}}

The end.\footnote[8]{At last!}

This' is the first footnote, and this" is the second.
The end.”
The first.

UThe second.
“At last!

\fnsymbol{footnote}etil g+ FE& & B2} footnote 7F2E]7} 1...99] Hd
o) 212} b ok 7o) 7| £ A B 4§ | 11 2
£ 7450 til A N T2 BE 25 NEE 93 S ool 44 45 Wss
W) Tk oheat 2ol sk,
This\footnote{the first.}
\newcounter{\myfootnote} . 5 L
\setcounter{\myfootnote} This' and that® are footnotes: please read note
{\value{footnote}} again.
and that\footnote{the second.} ;
are footnotes: please read note ztheﬁ“t'
\footnotemark the second.
[\value{\myfootnote}] again.
+9]: minipage UFolA = B hs B E9| 25 7F-E & 2h=tl|, mpfootnote©|tt.
\thempfootnote® L 7S QA4H3F 4= e},
4.6.1 Footnotes and Endnotes(Z}3¢} n]|F)
endnotes ™ 7] A= \endnotez}t= M2 HYS #| L3t} o] WS \footnote A}

2l th4l 2AH mo] x| stetol] Zk5=E &ol+= thAl \theendnotes H o] Fol= |0

Zoa] L EFh! Aol o] nhx|atol

= o
F42

2ot Qlzhate] & wol §-&ict.

INSERT M|+


https://www.ctan.org/pkg/endnotes

—

\footnote B o7 YejE|o] Y 72 E BA o] WEo| AT 52 4= ek
T2)7] glalMe majoysol b Bg Frte) .

\let\footnote=\endnote

)3 ofelie} 22 Al Zo] WS BA ool Aojdir}. 2

\newpage

\begingroup

\parindent Opt

\parskip 2ex

\def\enotesize{\normalsize}
\renewcommand\notesname{O|F} %% HA} 7}
\theendnotes

\endgroup

2t

rlr

cheat Zo] hepuey,

e

fo]zte olzolt}.

4.7 Insert>Indices(5x})

£ 23t ¥ Bx} Y Bx1 53 AASHE AL BpXolA URu 7has dolt, o2 a
2 S 249 A HAl \section = \chapter o] L} 27] Hoj Zojdom

\tableofcontents
\listoffigures
\listoftables

U7t ok 3 f1E Z2A Mol o]2fdt 7] 5ol ik, f1E Z2AA ] gl BIEX

A7} ol 2ol21ch. el 2|8 el

(%22 o dnotes 2 AlXIE I 2= EfO|S
0§22 \notesnameO| 7|§Zf
“Notes” 2 E|0f ULt 07| M= ot=0{=2
HHSH7| 2J8l O] 0|2 2 E renewcommand
SHRALE.
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F 3: <tabbing> $7ol| A AHEE= HH

gy =&
\= 8 A5 A& AR
\> U2 § &5 X 2 o] 55
\+ B AR A ST e 2% o2 nirt
\- B AR RS Y dFo 2 It}
\\ o] 2
\pushtabs ZE 8] AF 9x]& A3t
\poptabs  AZAd ] AF YA & E=j.
one . \hfill two\\ one o
\vfill
~ \hfill three \hfill
= ~\\ three
\vfill
four \hfill five
\null four five
Ak o 2 KXol M & 01%94 FHS o)z o dolx 24 Hhgstx] gk=th,
€ oo 32 v Fhte] Ful o g ZhEgtet dE{u EA1] B9t oK HE ATl
135 ool 3UE A2 ol of FhThm, “gebx| %] oHe FHQl ~ HE S ALgalet
ol g AHsto] B ¥ 02 hrh \hspace FF 2 ot %5723 Lz 712{0] Tf3101 \vspace £ 22
Yoz £ = QUCH CieF \vspace=
This is a \h 2cm) 2cio] ZRE CH3of (3L 23
is is a \hspace{2cm ors 5
2 ; o This is a 2-cm-wide hole. 2 SEXFH vertical mode Ol A) MOF ST
-cm-wide~~~~hole.
4.9 Insert>Tabs(%)
<tabbing> #7-2 TAB 715 &3S wjo] 521t fAte AntS Al gotct. €2ES A
(column) Y% 2 v 5}t o] AF&SIC}H 3 32 o] 3HAof|A] 2 2ol gag Qokslal
Art.
the REL B SR o Alo]ct.
\begin{tabbing}

%

~ \hspace{lcm} \= ~ \hspace{l.7cm} \=

@ g 43

~ \hspace{2.2cm} \= \kill % O] SH2 HA|SIA| %S
Zero \> One \> Two \> Three \\

Zero \> One \> \> Three \+ \\ % &I ZI¥ Q=& 0|=
Zero \> Two \> Three \- \\ % &t ZI¥ 2IZ 0|5
Zero \> One \> Two \\

\pushtabs % & |z &

new tab 1{\dots} \= new tab 2 \\
new \> tab \\
\poptabs % AZ3ME B (3
Zero \> One \> Two \> Three
\end{tabbing}

2o

=7 =




Zero One Two Three

Zero  One Three
Zero Two Three
Zero  One Two

new tab 1... new tab 2
new tab

Zero  One Two Three

<tabular>%} <table> &7 = Lol H A},

4.10 Insert[>Cross Reference(Zx}3 =)

HAEo] gpdll Z g el QX = A Est7] J5lA] \label, \ref, \pageref H 0]
AgETh 2 gL prefix:suffix A 0.2 0]%751% Zlo] wEA o}, of 7] A prefix+ of |
S =9 o2 2o} H(chapter) HE ol cha, $4] M S0l eq, 217 oll+= fig, A (section)
ofl+= sec, X0 tab.

A, 72 39 50| 5o Qe Ho|x & Fx5teW \labeld \refE thg E7|e} Zo]

\paragraph{Example.}
\label{par:example}

This paragraph appears in
Section~\ref{par:example} on
page~\pageref{par:example}.

Example. This paragraph ap-

pears in Section 4.10 on page 19.

E2 prefixs A1 9] nfgof] == Zlo 2 A= Hr} enumerate 2] AE0| &3
ofl & HA}

\begin{enumerate}
\item{first step: skip to
\ref{item:end}
< \label{item:start}} 1. first step: skip to 3
\item{another step
< (unreferenced)}
\item{end: go back to 3. end: go back to 1
\ref{item:start}
— \label{item:end}}

\end{enumerate}

2. another step (unreferenced)

4.11 Insertl>Margin Notes(o¥2)

Y& sttt \marginpar{text}gtil A Hr}, o] 7|52 & ZE2 A Ao = ZF
27] o2l Hold. B}l El

4.10 INSERT[>CROSS REFERENCE (A=) 19



4.12 InsertD>Text Frame(Z8|Y)

L egel o

=227 tekul7] i) 20l wo)%]

A H 9o "lAE T Y-S F2H textpos
dAS5(FF A)oll BT

nodog ERtEHAE
AFolof| Al Lhirof 2] 2] =Tt H|o] %
7] 2| & o] &35hH Ht. ' L ojAE
Ho| x| /o] £ |0l (|AEE 11
BAIZ1= Zlo] ot e <minipage>
(AIY=lo]#]) #3& & 4= Aot A=
H1 %l HlAE = minipage 2 TH&
o] 7 Zlo]t}. minipage HrAE 1A
ojofl A} o] A|7} Lt A A] =

.. O] BIAE = H|U o] x| & "tA
2 58 Aoltt. <boxedmini-
page>2730] 22 o] 52] w7 A]
o] 5tof AlZHct.

<minipage> ALG S T3 22 FA AL 4715HA.

\begin{minipage}[position]{width}
\end{minipage}
<boxedminipage>°l|lA] =&Yz} &l A

\setlength{\fboxsep}{5mm}

4.13 Insertl>Image(°|n]#])

0): o] X] (image)2t 18 (figure)& THE Zolth. AT A 4148
PDF, JPG, PNG, TIFF *° 5} 2 H o|n|z] &

S x3}sle] stohd oful AEE]E 7ol AFER

PDF=Z H3l5}= vl S ok 71 912 Zjo|T}, "
7333t 117] 2] graphicxol| Al A &-3t= \includegraphics &2 o|u| A& E 3

9}1

91

P
T

This is a lovely picture

This is a lovely picture
\includegraphics[width=3cm]{piper.jpg}

of a guy playing the pipes.
of a guy playing the pipes.

height, width, angleZt2 o=20[H & & 4= Ut} widtho] 27 ©9l= 219 27]9

M Zdol& Folk H a1 §AEL} 8 Zo]of /Jtigto 2 Fojsix Hr},
width=\textwidth % THO| F= H|

width=\linewidth s A 2Ho & YH|
width=0.5\1inewidth % linewidthQ| ZHt

At

e

I AXF= abspos TH7|X| 2 =Bt
beamerOi|A] textpos7t 27| =

§
&l
X|E I[loHDI- A OI|:|-

Hn im

(54526 M XH= TIFFS 047 M Q1Zstn
UOL} TAXH TeX Live A|AEH2 TIFF ZLEHO|
O|0|X|E & X| @SR =0t MAEsl
LE7E 0|23510] PDFLI PNG 2 convert
ljZ=0{0F BiCt,

(5F2ono|X| &% 122 H

otet,

20

&St g}


https://www.ctan.org/pkg/textpos
https://www.ctan.org/pkg/graphicx
https://www.ctan.org/pkg/adjustbox

\usepackage[export]{adjustbox} .
T B HXH=E “multi-column text O]
, - 3 o . HSHC T of 1 QoI A ILHE S710LE O
adjustbox 7] Z]o] [export] &A1= Fo{5ko] =51 \includegraphics HHOl oo xyxio x1ztol =aict. metst ojoj=
left, right, center, outer, inner®} Z+-2 42 3712 0 & Hojdt 4 9lr}, mpx|u}t = 7o “twoside(2T) HAE0 “f"*ﬂf’k ulel;
SICt & innergt= A2 7‘—|Ho (spine) &
SAL otk g A Eo M & Holo}, (Q2% mlo|x|o| 1% oIZ 111|O|I|0|
RQREZR) outergt= % R
Jtg|7|= ook

FWEQ &

This is a lovely picture This is a lovely picture

\includegraphics%
[width=3cm, right]{piper.jpg}

of a guy playing the

= pipes. of a guy playing the pipes.

H| ERY o]m| 2|7} PDF #l§| oju]z]of H|5tof FHo] 2] & 2 g Bk glrt
a2 a8 ojn|A 58 A 2ds|EH Ags] A= A ok

[7H dJustbox m-¢ gt 7152 AFste w7l Al ol #7| A& 2 =S uf [export]

FAE FeolAg 52 A, FH B2 342 \includegraphics §3 7 37 227

= [Export]E At

vertical align©l| 3t of| & sht 0] FRT}.

\includegraphics[height=12pt, raise=-1ex]{piper.jpg}

a3 57 9112 g £ 2o thstel ZAs)oF & w7} glck.
Zo|8t ML raise keyZ Y29 \includegraphics 7|} 5o AAsfof stoh= A
olck.

4.14 InsertD>Figure(&x)

28 (figure) 8732 ©]7]%] (image) S AFAH= AT YA ehrt. AHA figure ] W&
2ol ol A MR % gtk figure Wolx| We] T4 54 91218 2e

wrh & 20| ®E 4o] 23 18 Mol thatol mapEz e 4 ik ol Ag ok
20| <figure>#7olet. ot2fel £ F figureo] thet oIS 2ol Ziet.

\begin{figure}[htbp]
% [htbp] E2E7t =Y A& AY
% here, top, bottom, separate

<~ page. &)
\centering =
R 23 1: ©] A AHZHE UehE
\caption{O| QtLHA ZHAE L}IEILH= A0l g

— AOrE|}
\label{fig:mysmiley}

\end{figure}
Fdslor & A, figures ¥EA| ZES st bz 1 970 UEhdrhe Bagol
glthe AbAl o]t -r_]E Z2AA et s wste] 3A T2 o] figure 5ol AP H IR E 2|

4.14 INSERTD>FIGURE(&T) 21



\begin{figure}[htbp]
\centering

‘Gnuplot 30 graph

\includegraphics%
[width=0.7\textwidth, angle=-90]%

{gnuplot.pdf}
\caption{Gnuplot 2=}

\label{fig:gnuplot}
\end{figure}

etk 219

Sinfiex + Yy + yy) ——

1% 2: Gnuplot J12jx

21, figure 7} 0l 9% BIEXo] TeHe 71 1) )22 “njrhy =
(float)” ZAo|t}. 122 2 figureS 2| A% v “Chg 1270]Lp“9le] 2o T e uhAlo®

AFGoA = ote] 1 ‘T ~\ref{fig: label}\ & E 2} 2} Z-& Ao & Z=zafof 5t}
o3t A wj 2o figure®} table & ML} 7 (floats)et L B2t B2 E A
25| EASH Yo T AtHA here T{7]| A S AFE S 4= Ql=t] o] W7 A= H(“F &3]

©]X(HERE)©|2H= Seol o) 942] 214 A& Alg-ghct.
a-S Uzts] 2 3™ subcaption 7| A7} A Z-5F+= subfigure
o

=
= o A *30
ANE dS 4 Q.

\begin{figure}[h]

% first subfigure

\begin{subfigure}{0.5\textwidth} % half figure for 1lst
\includegraphics[width=0.9\1linewidth]{piper.jpg}
\caption{Caption of 1lst subfigure.}
\label{fig:subfigl}

\end{subfigure}

% second subfigure

\begin{subfigure}{0.5\textwidth}
\includegraphics[width=0.9\1inewidth, angle=-90]%
{gnuplot.pdf}
\caption{Caption of 2nd subfigure.}
\label{fig:subfig2}

\end{subfigure}

% whole figure

\caption{& 79| subfigureE 72l figure}

\label{fig:image2}

\end{figure}

subfigure

Az A &5 B EHS Bt S 072 wrapfig W71 4| & o|-§5te] AT 4= Qi

(% 29]  emoir/oblivoirOll A= here
47| XIS AHESHR| b=Ct.

[ g

[HF*30

Isubcaption 2|0l = subfigure,
subfloat, subfig S subfigure 7|5
HSdt= I 7F H AL
memoir/oblivoirOl A= XM BHEO 2T
subcaptionS & #= 11 O|H IH7|X|E &
& AL

(5531 wrapfig2ets 17| x| = efol
wrapfigS 748t Z0|C}. wrapstuff=
dEY etsict

Pror I 218 marginOfl &&= 2101 2t40]
UCHH <marginfigure>ete 22 S
H|Zdt= W2 [X|7F R AT memoir”t O]
SHE 2 XHA| X8t U, sidenotes,
sidenotesplus, keyfloat 50| 22 0|£2]
etE 2 MiSetct 71X 2ME Hostat

22


https://www.ctan.org/pkg/here
https://www.ctan.org/pkg/subcaption
https://www.ctan.org/pkg/wrapfig

(a) Caption of 1st subfigure.

Gruplot 3D graph

SinGeex + yy)ioex +

vy ——

(b) Caption of 2nd subfigure.

19 3: % 79| subfigure S 7H figure

If you meet this guy, give him some
< money.
\begin{wrapfigure}[4]{1}[5pt]l{2cm}
{\Huge

~\texttt{=8-)}

}

\end{wrapfigure}
The reason may not be clear to you,
but I can assure that your money
will end up in good hands.

I say again, if you meet this guy,
give him some money: he knows how to
use it properly. OK?

If you meet this guy, give him some money.

=8-)

The reason may not be clear
to you, but I can assure that
your money will end up in
good hands. I say again, if
you meet this guy, give him some money:

he knows how to use it properly. OK?

AAE A= 2HE 7] Yoto] BE SojoF T 39| 4, 2do] Y | (htbpe}
e XA HA}), Bojuj7] Zo], 17 e] Zolc}, 32 SF ) wrapfigl 91X MR I, v, i, 07t
QUCH 2p2f 2THol| CHSt] 1%, @ 2% ot
Efé@.OIEFE 9IE'IOAIEP. htbpt= Ef2| &
4.15 Insert[>Shapes(X®3%) SHLRFS AIFBHOF BHEf.
PGF/TikZ= Z2e|Yst5o] 23S AT & e vl A o7 A o|t}. b
o}z Zhekst ojAo] .
\begin{tikzpicture}
\draw[red, thick] (-2,-1) -- (2,1);
\draw[green,thick] (-2, 1) -- (2,-1);

\draw[blue,ultra thick] (0@, 0) circle
(1cm) node{\huge \LaTeX};

\end{tikzpicture}

ol2l Thest 2 ol 2Jo] A2 A AL & 4 k. TikZnet HEs| el

TR WYSIWYG 238187 EE:LEEHO] = 25t} Inkscape(https://inkscape.
org)E 2HFCE. o] T2 1AL PXE AT} Z 547} g2 E | YL WX 44
o= % 43tk

Inkscape & A5t HGst E&2 S 18 oS vFollA] Extensions/Text/For-

mula (pdflate)...

o]} Extensions/Render/Mathematics/LaTeX (pdflatex)...<

EELE

4.15 INSERT[>SHAPES(=¥)
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https://github.com/pgf-tikz/pgf
https://tikz.net
https://inkscape.org
https://inkscape.org

PAoz HAES T o3 Apply & 2T KXol ofsto] 2Hd

LaTeX input:l\LaTe)({} math: Se ~ {i\pi}-1 =09 ‘

Additional packages (comma—separated}:[ ‘

[ ] Live preview

Close Apply

Eile Edit View Layer Object Path Text Filters Extensions Help
Do &8 3aE| - 0OY B @aa oa®l v

-250 0 250 500 750 100
| ‘.I [ | |‘| [ |.| [ |Y| [ |‘| |.|.|.|.

@

] B
Ké_ L S - T
Rk @lEX math: e 1 = 0w

Q ’ S

Oz i

Q - shapes

O -
& & 3
© - normal text 1Y
E’o{ I
t 2
AI T | i
> @ | | = | °

XEEEEENT A EEN NN EEma—————c
D

(T
Coke: INCTES 0. [0 [| & 3 -Layer1 ¢ | Group of Lobje o33 ([ 35% |3
1% 5 BEXel AAS Hx el A

s AL AT 4+ Aok &44%E 192 PDF, PNG 5 BIgXe] Al gsts ZHio s
W2 Ui7]5ke] 285k .
o (o] o E

« GLE (Grahics Layout Engine) = &35
= 2399 dojolnt. [L..] GLE= 1Zef =F £of HlAE gl 4] 23 KX
o o]&3s}aL Qtt. https://glx.sourceforge.io/

24


https://glx.sourceforge.io/

3
i
L

AE] Tef 7)4 Qofolct, HlAYZE =L 187 9
ma|J e g A FFTh. BhHat 548 BEX 02 mR e
https://asymptote.sourceforge.net/

« Asymptote+ 49
A 222 23 7

oo

« LaTeXDraw+ BIEX < 93 18 HYY 7|0t}
https://latexdraw.sourceforge.net/
« Graphvize 7H5H BlAE Qo] 2 TS 7|&stn KXol £33 tojoj1ale
THET
https://graphviz.org.
ol W7 XS o] &3 BIEX S SIeH 2T B0 =8 1L A2 4 Ut} ofdfol =
@t} “LaTeX vector graphics” = U< A5 Het.
a8 4 Q= ‘=F’0 7= o2 717} Aot TEX Showcase H|0] 2| & HHEa] HH
Zolg AF5He of2] ol AT 4 U Aol

https://www.tug.org/texshowcase/.

>

4.16 Insert>Page(@|°]A])

F 3 overfull 2 ‘Of|2f’ 7} otL| 2t & 7ol Ct,
J2iLt 5 =5 N|st= A0| £t

fe:]
=

3 PDF 3]0] A2 overfull o2 5 U gk31 EAIZ AHUsHe L pdfpages 3714 S
2w 4tk et 22 Aoz Abgdit.

\includepdf[fitpaper, frame]{pandoc template.pdf}

o] g2 2.4H0]A EQl Pandoc 22 THE0] A= PDF #A & AU ST}, th-Z #| o] A]

+ 9o =5 A5 A7t A/dE PDFE \includepdfdt Aztoc,
pdfpages= °lHol= 2] 7}H4] 7|5-& ZE5al gloy 5i7]2] EAE ¢fofi = Zlo]

4.17 Insert>Rule(FA)

dojo] Zojet FAE 7HA= A& \rule P 2= I}

This is a page-wide L .
rule:\\ This is a page-wide rule:
\rule{\linewidth}{1pt}
but this one is shorter but this one is shorter and thicker:
and thicker:\\

|
\rule{2cm}{2mm}

ot SH22 o g, S 28 \dotfill Fo] . fast 2S A48T

£
ok
ol
s
o

Total price \dotfill \euro~10 Total price ................ €10
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https://asymptote.sourceforge.net/
https://latexdraw.sourceforge.net/
https://graphviz.org
https://www.tug.org/texshowcase/
https://www.ctan.org/pkg/pdfpage

This is the title:
now write the rest

Guido Gonzato

January 2018

Abstract
This is the abstract.
Contents
Section 1
Subsection . . . . . . . . 1
The End 1
Section

This is bold text, this is emphasized text, this is normal text. If you're bored,
go to The End.

Subsection

This is verbatim text.

The End

My dad used to say:
Damn, Pandoc has not been invented yet!

but not it has.



4.18 Insertl>Hyperlink(slo]Z g 3)

hyperref 7] 2|4 URL % 9|% 229] 58 WHE0] PDF7} B2k 7hsstA o
< ol& &8 o] T4+ o2 o] Ak

ﬂll
2

\usepackage[colorlinks,
urlcolor=blue,
filecolor=magenta,
linkcolor=darkred,
hyperfootnotes=false]{hyperref}

A o=

\urlstyle{same}

The \hypertarget{ctan}{CTAN} main site
is \url{https://www.ctan.org}, a.k.a
\href{https://www.ctan.org}{CTAN://}.

Listen to \href{run:midifile.mid}
{this MIDI file}.

Click \hyperlink{ctan}{here} to go
back to the top.

The CTAN main site is https://www.ctan.org, a.k.a CTAN://.
Listen to this MIDI file.
Click here to go back to the top.

JEA R \url B WHE IVE Q4T BB 2L B2 A Ao

th2 HgdS \hyperref A o] 5o

\urlstyle{same}

\hypertarget¥ \hyperlink 852 tHx| HTMLA Y Ui 25 A3ttt \href
2 URLOIY o mpl 2] A& whErh F5 22 run: mheto|gojot. HE D]
tlo] E2folo], ulA S§ 2T 5 R T2 O3S AYStES L 4 Itk Hit o]
7|°s2 PDF 2|tof w2t x| lo] &#] &2 4 Ut

hyperref H7] 2] £A & Yol HA; o B2 AAlet o 4 Qe 45 & 4 Ak

4.19 Insertl>Comment(F4)

FAES THEHH %5 ZF 9 ool Z0]AY comment 7] 2|7} A E-5H= \comment,

\endcomment & comment 73S &},

This text % boring example

\begin{comment}

what a boring example This text is just an example.
\end{comment}

is just an example.

S SO URL FAE
USH, HA=22 O
. C

y LT

tet 21| om0l M=

[g‘?y’]memoir/obhvonrOﬂH IHHo =2
<comment> A2 M STICH
\commentson, \commentsoff HHOZ
0| EO[AL &4 == ULt

4.18 INSERT>HYPERLINK(3}0|T{2! =)
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https://www.ctan.org/pkg/hyperref
https://www.ctan.org
https://www.ctan.org
https://www.ctan.org/pkg/comment

[

B *lpdfcomment= X3TEX S X 2/8Ex| gt
PDF 2820l ¥ =EA A5 £0]7] AsiA = pdfcomment S| XS 2 oiz 42014 212t soul 2 17|
o5l IposS O| IH7 | X| 7} &5V 20

=k of QoA bz} 2ol IS, ol PDF 418 ol o g mate 0 soubesBolIEII SO A
U == UL} pdfmarginpar2t= ZHAS
[icon=note,color={1 1 0}]{pdfcomment} 11H9\7£|7f"'9'4Pdﬂatex‘j*i'Er _'t”oﬂ

H|=ot 715& 2 todonotes = A THE
O||:|».

This text is nothing special
\pdfmargincomment{yup,

— definitely.}, This text is nothing special, but it con-
but it contains a couple of
\pdfmarkupcomment{nice}%

{simple, more than nice} comments.

tains a couple of nice comments.

PDF ¢ %49] 79 PDF Holo| uet A Astx) g B 97} 9-S Fopra,

5 Format Y%

ez o = A9 7|2 2 £/d& AAsH] /s = \documentclass 9| A=
Hojsich AAsh 4 9l 302 7|E ZE F7](10, 11, 12pt), £ A (adpaper, a5paper,
b5paper, letterpaper, legalpaper, executivepaper), @& (portrait, landscape) 22 Z 0|

At

\documentclass[a5paper, landscape,12pt]{article}

EE 370 thsto] 5.2.3% 0l o A5 szt

5.1 Format[>Line Spacing(3 7+%)

setspace M 7| X|= <singlespace>, <onehalfspace>, <doublespace> &7 A&
2]1 \spacing{amount} H (&)= 2l 3 7+4 k3 AT 4 U}

‘il: rOl'
&
L

o L
= memoir/oblivoirOfl A= setspace =

HT2 2o ot (RH2XE teXt=
ofs) 2 B BHS A8 4 QL

[9 &} \singlespacing, \doublespacing, \onehalfspacing> 3ol 1, <single- mlﬁEH\singlespacmgOﬂ fesie

space>, <doublespace>, <onehalfspace>= &7goltt. do]o] Y3+& A S= <spacing> \Singlespacing 0| A1 <spacing>
_ ] _ CHal <Spacing>& M H &= 40|t

2 ...ingQ & ARt g olt}. o] el ja 2= 1 FHo] TR Eojof ZIrt

Uepdt,

\begin{spacing}{2.5} These two lines

These two lines \\
are crazily spaced!

\end{spacing} are crazily spaced!
\begin{spacing}{1}
Much better, these lines\\ Much better, these lines
are spaced normally. are spaced normally.
\end{spacing}
BF 5l stm0] 2ME |2 B2t 2 S
; - . — The 20| AUCH koTeX AIZ Q| THZ [ X S0
A Aol 2 Y A -g 22 25t \linespread{factor} 82 ZaA [1ingu1] g4 4g%é M= 13 BT ol
= ™ o}, (o) 7o 10 38 o] ZFo] A% ™ 3j Ao AT Wolxl S X ESIC oblivoirl 2= 232
Boll =9 Ft}. factor? 7|27 1o/t ] gko] AAIH 3 Abo]o] ZHA = Hojzict, SIE TN O | vtano] TS 2
B2 o=k 1.6 A :=9] ghol Hrt Hgstm Qlct,

28 FORMAT il =


https://www.ctan.org/pkg/pdfcomment


yup, definitely.



simple, more than nice

https://www.ctan.org/pkg/setspace

5.2 Format[>Character(ZA 2%)

EFHY 24 BY 448 E 1o SASGY EE 7|8 0Bt WYL B 5T et
QA E= ZE o] AR 37|+ documentclassol] F-o{H 7|2 37](10, 11 -+ 12pt) ol uf2t
etz ® 62 Hat
22 &4 B89 27 oA
\textnormal textnormal main document font
\textrm rmfamily roman
\textit itshape italics
\emph n/a emphasis
\textmd mdseries medium weight (default)
\textbf bfseries boldface
\textup upshape upright (default)
\textsl slshape slanted
\textsf sffamily sans serif
\textsc scshape SMALL CAPS
\texttt ttfamily typewriter
\underline underline  underline
\textsuperscript n/a this is superscript
\mathrm n/a X"+ y" # z2"Vn # 2
\mathbf n/a x" + y" # 2"Vn # 2
\mathsf n/a X"+ y" #£ 2"Vn #£ 2
\mathtt n/a X" 4+ y" £ z2"Vn #£ 2
\mathit n/a X'+ Yy £ 2"Vn#£ 2
\mathnormal n/a x4yt # 2"n F# 2
\mathcal n/a XN L YN L ZNYN £ 2
E4: A EY

71221 A A (italics) 2 7+ 24 (emphasized) 9] xto]ol] thsl g @sliof et o2 ol &2
B \emph3t 20| HL2 4 HA 2 Hof 918 & 4 9lrh. 0|2} 2Fo] \emphi: A2
Efo & 12)1) 5 2| g5k ol ohet £2]% Z2E el Byl Aok

\textit{For example, this . ) .
For example, this portion of text is

— portion of text is typeset

< in italics, and \emph{these typeset in italics, and these words
< words} are emphasised in are emphasised in upright.

< upright}.

S, ofel Y AHs 44] BEO AT ALEHE o]

R ) dukxfo|c}, BE ElAEo| ALE5}E
theat 22 B & 4 QI

this is
$ {\mbox{\footnotesize%
{subscript}}}$

this is subscript

BE 9513 2 AofA O] =2|H 24X 2
s Zi017t0) HOt2 BES QiCt

Of & A|
ELAHTYM = tHHIZ =2 MALE
JEHZ HootE Ag H2otEs Xoitt. 0f
QLM HH RO M= O =X O 2 A2
7120|1 gFE HE (25 Ul Bels
B A E LEH O 2 HOHS A=
Y2l0|2t 5h7| oLy, JH2 I LHES
HArRE ZH7F AL £2 A
OHRIFCE Zx B2 2M HAIXt0fA|
BAM QCt g 4 A0k

=l olajet E2lg MX
\textsubscript &S
EIAEO| OfHN™XIE Xs
\textsuperscript T OF

ot K

ne
=

S

2 1> o
330
A0S

5.2 FORMAT>CHARACTER(SXF 2 &) 29


https://www.ctan.org/pkg/mhchem

EE 37 o Al

tlny sample text

scriptsize sample text

footnotesize sample text

small sample text

normalsize sample text

large sample text

Large sample text

LARGE sample text

huge sample text

Huge sample text

5 EE 37|

Default font size 10pt 11pt  12pt

tiny 5 6 6

scriptsize 7 8 8

footnotesize 8 9 10

small 9 10 10.95

normalsize 10 10.95 12

large 12 12 144

Large 144 144  17.28

LARGE 17.2  17.28 20.74

huge 20.7 20.74 24.88

Huge 24.8 2488 24.88

6 LIIE B9l 2 Lhehdl A4 EE 2]
thgoll @& 22 AR lafgit}. ¥REA12 \ce B 9] IAtE Y=ot

\ce{H20 + C02 -> H2CO3}\\
\ce{CaC03 -> Ca”™2+ +

— C0372-}\\
\ce{C03"2- + H2CO03
< HCO37™-}\\
\ce{CaC03 + H2C03 -> Ca™2+ +
— 2 HCO03"-}

-> 2

H,0 + CO, — H,CO;

CaCO; — Ca®* + CO;2~

CO5%" + H,CO3 — 2HCO;~
CaCOs + H,CO3 — Ca*' +2HCO;~

H| %t

S 13 chemformula 371 2] = A},

52.2 RE 7]

U= 27| 2] g Zo] detdolt}, o] A2 of|d A7 | 2 22 26 A -] f4to g

A B7] A= g}, dfo| = E7tatal WES HhEA] Z1ojof St ulem B 7| X &

2™ %E]- ' oh3 o Ao A o] BjF]| X7} Al g5t WS o] Qo] H 7HA] AEL S [g'jX'W]kOTEX IZ7|X| S0 A luatexko= XHA|
ulem®F BH S MSSHCE XgTEXOlLt

LS A pdflatexO|2tH ulemS B2 23}
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\uline{important}

\uuline{urgent} important urgent boat wrong
\uwave{boat} D
\sout{wrong} teitoved

\xout{removed}

ulem 517122 &4 glo] Z=310 \emph HH - Aol sto] o]
upRT 0|21 wskel W The 3t o] g4 Hofste}.

\usepackage[normalem]{ulem}

B = K

5.2.3 Format[>Character Size(Z 24})

EIEX O] EE Afo|22 &

25 85| 8-12 X1 E

o) 2%
ot

F 2] &thA extsizes W71 A7t =2 Zlolth, B& B4 =g
14,17, 20291 E §4 F7h2 Rof & 4 91| sheict
17pt article S 2/dote] ek gzka At Jeim chg3t Zo) Al &sha

&0l €

\documentclass[17pt]{extarticle}

2 272 A= g2 3L typelem W71 A & o] &351= A

\fontsize{72pt}{72pt}\selectfont
No Smoking

(o] ol A|9] ARt o] EAfol HAIS7|ol YR 27| wlgo] At ol A5
217} £E A7)9} wjo| 2atel (4) 2] Zolo]r}

wohe HIYPHOR thgat ol SHe SE Y.

1-cm tall

eIk £

QX

¢
2

N
T

\resizebox{!}{1lcm}{1l-cm tall}

1 ©HEE 2 A2 HAI5hH= lettrine lettrine 7] X2 \lettrine Y& o|-&
U k. ole] 74x] ALg 487} 7k ate] o] ool 4 Hel AL T8} o] 7| 27ke
2 2= Zlo|,

\lettrine{D}{ropped} capitals at
— the

start of a paragraph can be
obtained using the lettrine

— package,

DROPPED capitals at the start
of a paragraph can be ob-

tained using the lettrine package,

5.2.4 Format[>Character Font(ZE

BEX 2 Y 52490 ZE A|AHRS 7F2T Q1 7|2 282 Computer Modern©] T},
METAFONT A EA| ARl 53 2o g wjnjtt 288 ZEES 2522 A4t o]F 7

[HZF42]
7| X|=
INEEESION| Eofi A
lualatexOl| A= 50|

ulemJ—f

ltypelcmE 222 typel CM2EE
AMst= 70/0] 20l M 20|17t ALt
WAl QEEIY ZEES AFE8h= TX
ATIo A= O] THZ|X| 20| = ORI 7k FAlet

P9 oot ZHE H 2 + UL

(5544 ok )| 47K adjustbox Ol
\resizebox 2} OFE7EX| 2 BEA XN E
otoliShH= HEO0l Fol[of QUL 222 o2t
A2 s st E ot Y2
\adjustbox{height=1cm}{1-cm
tall}olCt.

31


https://www.ctan.org/pkg/extsizes
https://www.ctan.org/pkg/type1cm
https://www.ctan.org/pkg?lettrine

Sto

s
ey s, BIEX PostscripT Type 13+ 2Z€EFQ] OTF

avant, anangar, bookman, chancery, chanter, courier, helvet, helvetic, ncntrsbk

s}

=

o

2 o' Ao 5U3E 23S BASHo]
+= @A, Times, Helvetica, Sans Serif 5 T2
o x| &

Ui

newcent, palatcm, palatino, pifont, times, utopia, zapfchans-°] Type 1 ZEE
&g o 48 mj7] 21 Eo|t}. \usepackage{times}S Ze|YEof Zojdo

A ol v
T}\}]\]__

o gA == ZQlsf] He}. o] A+ libertine 7] 2] & ©]-&-5H3 Tt

that, 4418 tHE wofl&= Computer Modern EEZ #-835}= Zlo] & 4olat= o
o5zt o EEE ARG 428H4]o] F7t o] dE AE ThA 2t

FUIZEe} ERERR], QY EEE A U5H= xelatexZ o2 204 & 4 l=
2o] A ottt LaTeX Font Catalogue A EE 5t of® ZET}F Q=4

Hols) KA},
otoll A AGFSH 7| A EL A AA o] ZEE HAS}E= Zlolt}, 247kl EIAEOTE
% Zg5te] gt ok oAl A Hol ZXH font family S 2| szt
+= font family & 3 70l 2 2FaFAct. X font shape”t LRoll A& A Y= ]

Sl })]\E‘]"“f AFA S dop=at,” “46

This is Computer Modern Roman,
{\fontfamily{phv}\selectfont
this is Helvetica!}

A7 7oA AFE 2 919 oAl XpTEX 02 Hrpdshe Mo Holx L AdsA
LE,L*‘E‘:]' I Al ok ofjef Zo] dlofof gttt Latin Moderno]h CMollA] 2 2 ZE}Q]
SEEAN XgBIEX Q] 7] & ZEo|1l TeX Gyre Heros+= Helvetica©oll -85+ TeX Gyre
2E(eEER))o|th EE el 95 fontspecd ZE3|o} SH=T] pdflatex o] 7] 2]+
A QskA| =

il

ou—ﬁ

4

\fontspec%
{lmromanl0-regular.otf}%

This is Latin Modern

— Roman,

{\fontspec%
{texgyreheros-regular.otf}%
this is Heros!}

This is Latin Modern Roman, this
is Heros!

5.2.5 Format[>Character Colour(Z*} A4

color T= xcolor 7| A2} BWad g o 2 Zx}ol A& 213l 4 9k, 7|2 A 0 2 black,
white, red, green, blue, cyan, magenta, yellow 7} 2] %|o] 3lon & Q35tH M-S 2}

Alo] o 4 k.

ETUIEE Ixiol fa e Alisls

ATIO IA| 2R E Lt O] 22 F2
pdflatexO| ZI ATIQl &A2tOl| ALt
FO|0ISICE HARZE xelatexS 0/ E5H0
ZAuidsh=0 0| i o2t m7|X|:= 2|0[7}
AL FOfel M At sH{OF BT}, F =
libertine I 7| X| = pdflatext xelatexOll A{
D5 FESHA SEfetct.

rl

(5746l | 2etof| A LSH= font family, font
shape 52 pdflatex QIEI0| M MO|= EE
MeH x| AElo] ofo|Ct, RLIAE ZES
st ATl A= o] atol LYol
MEE|X| gb=Ct B 7= OFEIEXICE

[

(S ESI

(%97 0|2| Mol El M AHE S xcolor 7t
CIFSHA| M| Z 5t Q2 latexcolors,
ninecolors S M4 o€ NSdt=

7| X|Z0] QU
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FE ue 9y

=
cmr Computer Modern Roman
cmss Computer Modern Sans Serif
cmtt Computer Modern Typewriter
pag Avantgarde
pbk Bookman
phv Helvetica
pnc New Century Schoolbook
ppl Palatino
ptm Times
pcr Courier

\textcolor{red}{This is red.}\\

\color{blue}

This text is blue!\\ This is red.

So is this. Let's change.\\ This text is blue!
\definecolor{mygreen}

{rgb}{0.1,1,0.1} So is this. Let’s change.
\color{mygreen}

This is my shade of green!\\ A cyan box

\color{black} -
\colorbox{cyan}{A cyan box}\\ ‘A green box in a blue frame ‘

\fcolorbox{blue}{green}
{A green box in a blue frame}

L}ol7} \pagecolorgh= o] et ofH ATE 7H4 .7 shes W Q] A2kt
AR

5.2.6 Format[>Character Outline(Z4 24})

SRl VS dsle Ao FEX] i‘:}‘?i contour ﬂHﬂﬂ% o|-&5to] FHAl (2ZA)

7}
ZALE ghEo] Bk, \contour 2 ZAE 16WH (= A A= 40E) HA A
LAl g ThEol i S sk 20l = MBIt HEE)

\contourlength{0.5pt}

\Large

\textcolor{blue}{\contour{red}

{Blue text, thin red outline}} Bluetext,thinredoutline
\contourlength{2pt}

\textcolor{white} mwﬁ}ﬂéh[ﬂhmaﬁmm

— {\contour[32]{blue}
{White text, thick blue
— outline}}

5.3 Format[>Paragraph(£% %) So| #Roke CH2A| SRt \\ 2
. . N ol ‘2cro| oLl S
oo\l 22 P gl AE0] 2 1 Peht BEXo] FASHE AYS AIe oo Aol mE oot

— o=

th2 8l E0[Lf \parZ
\

2}, 49 ELtE AS LT\ E B o 2
Lol M2l Al SBHE0|CH
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L2 A

abstract QokF

array S8kl of ujd

center 7t g4

description AR B AE

displaymath H3Y 2T (displayed) 424
document A AAE s B
enumerate HoH ZAE

equation H3Y FY (displayed) 84 (£ARIS B4
figure Hoye 19

flushleft LAk |

flushright LEZ Y

itemize RS R 2AE

letter HA P4

list 714 2 AE &

math 3% (In-line) 54

minipage ojuof|o] 2]

picture HAE Sax )4 o 59 =3
quotation ozl B AERE R & 5927 A7)
quote RGOSR (A & 5927 g2)
tabbing 8 AF2 o] 8T AHE

table oY= &

tabular Wi 2 JEHEH HAE
thebibliography &3 5& 2|AE

theorem e, HA 5

titlepage A A A

verbatim dYES = Ho|7]

verse At &+

&7, ol Y FAoju 2E B 58 Holst] 95
t}. o] AL nbx| nfe AR HAE JHE Heds)o]
AU MES Seshe 23 AT FRER PaE

\begin{environment}
...text goes here...
\end{environment}

olg SolR ). o Be-g 1eu B2 ok <center> BHE X SWTh.

\begin{center}

this text is centered this text is centered
\end{center}

EF 2732 B g0 2otk ofel 1AM S 2 7] Bojzid.
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5.3.1 Paragraph[>Horizontal Alignment(J¥)

7|20 T FEREFOoR FHo, IF HHolu LER
AE L <flushleft>, <flushright>, <center> ¥7 o] HIAE S W=t}
\raggedright, \raggedleft, \centeringo| o] &7 3} z}7}
S HEAT, 2R Fo] AlAeH] A7kl B UEA] =t

5.3.2 Paragraph[>Vertical Alignment(Z% Alc]e] &)

2ohe FREHE BIEXS] WA 95 ZRAN AH8ALS 0] 9RFehs B0t 5 At &
Fo]i} o] of2] 7 obi SFLfe] ¥l &, sHFS] FHj O 2 ZHEgH), whebA] ¥l £ ol
7| ok siA] Bk Abo] 7} ] Moj x| o] ohehs ot} \smallskip, \medskip,
\bigskipoleh BH & £tk Ato]ol A Z 0.2 Fofgojof Rt} Rtk Alo]o] 72 &

Ag 4 9k,

o2t 7+4-S ¥ Ak \vskipS thg H7|9} o] Zojg o Hr}, 0

These paragraphs will be sepa-
rated by 1.3 cm:

These paragraphs will be

separated by 1.3 cm:\\

\vskip 1.3cm

there is a 1.3 cm gap above me.

there is a 1.3 cm gap above me.

\vskipe ©.27] B Atolo| gt SAgt}, A28 0] o] Aol (= ol o] Bk
gl Aol H) o7t 1.5cm o] e 31 BE-S Alashi ATk ofH A ot Frk

o] 5
\nulls (Sle 29 tidl) ‘B2 2 Ao} 2HA-& A sl o gt '

\null
\vskip 1.3 cm
This text comes after 1.3 cm...
This text comes after 1.3 cm...

Zoz \vHL Bo]| Utk & B AfolE ¥l 7o AeE o g £ 5
#Al Beke @4 1 mlo] 1o vietol 07 Bk, thg o2 Faale}
This appears at the top of This appears at the top of the page...
the page{\ldots}
\vfill
{\ldots}and this at the
= bottom, ...and this at the bottom.
5.3.3 Paragraph[>Margins(Z% )
25004 2 v}, R EL B AAlo] A A8 s Zolct. § Mol Bk 2 Wi
Sh= A4S AwhH o 5 gEX) orech, 8 Brre] Bk B2 U 2 Aste s ok
o AJol A Hol= Zut Zo] 22 7S 2/ slof gt

(5550\yskip 2 Tex B0 1 \vspace=
BTEX B FOICH E[=5 \vspaceE 4= F0|
Ol X| gt o2 E X[ 2= RULE \vskip
2 ofAlof A<t 2ol Zalgte T FHol .,
\vspace= ZO0|E ZZZE S2{MA
QIX}Z M sICh

(551 prex 2| \vspace THO| HEZS
=0 A \vspace* YA OZ MH HHO|
F0{Z1 /%] O|™ (% o|=)0f| 7| & 2¢to]
SO X ZHAS He 7| R 220A
MESI D Y= AR L2 ETHE FE £+ ULt
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\newenvironment{margins}[2]
{

\begin{list}{} {
\setlength{\leftmargin}{#1}
\setlength{\rightmargin}{#2}

} \item }

{\end{list}}

o] M=o Aol 2

As you can see, this paragraph
has normal margins.
\begin{margins}{0.5cm}{1lcm}
But please note that this
paragraph has custom margins.
\end{margins}

normal margins.

But please note that this
paragraph has custom

margins.

As you can see, this paragraph has

5.3.4 Paragraph[>Indentation(£°]27])

24 3 & So27)9] 2718 YokelE \parindentelE Zo] Mol e AP @,
02 B7]= 59275 1em & st Z o]t
\setlength{\parindent}{lcm}
\indent®} \noindent P 11 thZol| 2= FT2] 5027 E A|ojtt.
O & \parskip Zo] ule}n|g| 2 Btk Ato] 9] 7HA -2 A HE 4 Qleh. >
\setlength{\parskip}{3pt}
5.3.5 Paragraph[>Border and Shade(Z&|Yd3} 3%9)
2o|u} dojol T2]9)-g X2 BC framed 7148 204 E£ \parbox B L 3
8514 ==t o] wj calc 37 x| 7} & @5,
47| framed & ©o]-&5}= of| & HolA}.

\setlength{\FrameRule}{2pt}
\setlength{\FrameSep}{5pt}
\begin{framed}

this is a framed paragraph! this is a framed paragraph!

\end{framed}
\definecolor{shadecolor}{rgb}
{0.9,0.8,1}
\begin{shaded}
this is a shaded paragraph,
do you like it?
\end{shaded}

like it?

this is a shaded paragraph, do you

Ho

o=

[(5F7520 0| oL MOl A= M2 Bt
FHolstod A1 A=E, memoir O]
<adjustwidth>2t= 2t 40| 0| 7|51
FALSE S MZHC. mem0|r |
changepage IH7|X| (GII T 0| &
chngpage) 2| 22t SYSiCt.

7e]

t

[eAZ*53] metd, 85
EMME 2S¢ ALO]Of
He o, ZNZ 8 FES Sy O
20| otL|2t= ol =elst2t. \parskipS
BHPE SICHA parskip 7| XIS ALES
20| &L

%5 emoir/oblivoirOfl A= framed

7| X2 2 7|5S KM FEH St  UALE
BHH I Bl A E 150 QU0 A=

2Fot IH7|X| 2 adjustbox, efbox 2/0f|
tcolorbox S BtEA| g8 &2 $iCt. Of
HHEL I | XK= HASH A S T2|=
=Hof AoIM B2t HO tiRR 7|58
M| Z otk
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71231 boxedminipage 7] 2|7} =], 22 o] &9 &S e
ES I oh3 3 22 YRS Wel= A2 AM <boxedminipage> 735 2= AT

o

o]
=

oft ok

ol
—_

\framebox{
\begin{minipage}[c]{\linewidth}
text to be framed
\end{minipage}

}

At & drtthd 549 Aol S A8l = Al
Fo|% el Ao Tk Zlojo] mA Qg LB
this is a
\framebox[\width]{framed} this is a word
word

this is another
\framebox[2\width] [r]{framed}

this is another

word word
A A QAR = oFe] Wi-o] T uje] FH WHAlS A A7), o] BIo|A =

2% () Joltt

5.3.6 Paragraph[>Colour(Z% 244})

2oio] mele H oy of 4] A At Alct, o2 A s,

\colorbox{yellow}{
\begin{minipage}
{0.8\linewidth}

I am a minipage, my
— colour

is yellow!
\end{minipage}

I am a minipage, my colour is yel-

low!

3 ] 80% % A 85 w5 MAstglc).

5.3.7 Format[>Columns(thdh)

\twocolumn®} \onecolumn HE-2 A2 H|0o|X| & d11 2} TE = 1T 202 A &S}
\documentclass®] A otetu|e] 2 2|4 & Qlt}. o] A o2 S8 A
)| 7] 2| 7} A|-8-5h= <multicols> €73 0] It} o] & o]-85}o] o] Ao] &S ojto = Zit

shat ek ohe A s Role.

e

2 I7|X| 0|F2 multicols2t1l
Uedl, M2 2210t SHEH| Xt
HCE multicol 2] HH2 HIEA|
H|O|X| £ A|Z}SHA| b0t EICh=

CHe|AES TEe 2 QICks Folct,

S 2 > Ok
huox k1 H
ot

H
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\columnseprule=1pt
\begin{multicols}{2}[\subsection{\entry{Format}{Columns}}]
The commands \cmd{twocolumn} ...

\end{multicols}

o Ato] o] A2 \columnsep Z o] M2 Aojgtth \columnseprule iA 2= o
Atolo]l oAl Ao #7]15 vebdich ¢ tiZ S 2 52 4 At el AEE ohih 34 2

A7) Aol s #740) GBS WA Y 2HsH Rt B
6 Table W+
212 (a2 =7F)oll 24 AE &gt} o] et FA|E of 7] E A

o]0 x| (image)7} figure9t= Th2 Z3t uFAIIR| 2, <tabular> 3747} E (table) = N 2
2o}, KX 9 tableo]st 12 wthu = 7iA) (4.148 0| A ™) Z A 3t o] x| & o7}
2 &= Zlolojof sttt M-S & 4 A A E <tabular> 7S 11 Qtof] ZESIcH
<tabular>+= 5H3 FH 0 & = sfof st=t] o] = Hd szt

7] BIEX tabular 7§14+ th33k Zro] A elgict.

\begin{tabular}{|l|c r|}

s =%, Y, 2= 4™

s AE2 3, MES

s NEE2 #E 0|9/EO0|A StC}

\hline 1 2 3

1&26&3\\ % &9 & a c

\hline 5 o8 A one | two three

a& &c\\ % FHH ZH

one & two & three \\

\hline

\end{tabular}
o714 424, A, Aol 48 AR AL B 4 AT}, tabulare] & WL &0 2]}
£o)8 AAUESE o) oAk,

booktabs 714 & o] 51 A2 o] Gt o AlUE 2YE 2% tabularS 12 4
9,1‘;]'.*57 (%557 memoir/oblivoir= booktabs 2]

7|s& KHA| X[ @5t ULt

\begin{tabular}{lcr}

\toprule

1&2&3\\ 1 2 3

\midrule

a& &c\\ a ¢

one & two & three \\ one two three

\bottomrule

\end{tabular}

oh2oll Hol A o= tabular 7§31 S Zofgshs WS Aot
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%48 B; AR/ZY/Q2Z HY; 1Y
\begin{tabular}{lc|rp{4cm}|}

\hline % =g

\textbf{Left} & \textbf{Centre} & \textbf{Right} &
\textbf{4 cm}\\ \hline

I

row 1, col 1 & row 1, col 2 & row 1, col 3 & row 1, col 4\\
\cline{1-2} s 1-2 o M
row 2, col 1 & row 2, col 2 & row 2, col 3 & row 2, col 4\\

\cline{1-2}

\multicolumn{2}{|c|}{spanning two columns} & row 3, col 3 &
row 3, col 4\\

\cline{1-3}

row 4, col 1 & row 4, col 2 & row 4, col 3 & ~ \hfill right\\
s ~0f| o3 2|2t

row 5, col 1 & row 5, col 2 & row 5, col 3 & left \hfill ~\\
row 5, col 1 & row 5, col 2 & row 5, col 3 &

~ \hfill centre \hfill ~\\

\hline

\end{tabular}

Left Centre Right 4cm

row1l,coll rowl,col2 | rowl,col3 rowl,col4

row2,coll row2,col2 | row2,col3 row 2, col4

spanning two columns row 3,col3 row 3, col 4

row 4,coll row4,col2 | row 4, col 3 right

row5,coll row5,col2 | row5,col3 left

row 5,coll row5,col2 | row 5, col 3 centre

tabularray

o] 24L& a7t F745ith. T E (tabular) = 235t BIEX AHEAHE M E352 EA%TH

ot @ Lot A 7ol tf-gshs £ 74, 71X S0l U= tiEe] 277 A 755t

Al = out Y7 g2 a2 A wj 2ol 25]2 Falo] ot l=A] &7 of 2 A7t H 3l
tabularray = =25 T8 = m-¢ Y taL Q1 5jj7] 2] o]}, o] QMM & st

LE3of| tfste] ARt EA0A A7ISkHe 79 tiFE2] 7]5& key=value &= °&

Sto] S 4 ok et i FdolA Hshes Ae #Fe 4 US Aotk

Qlof AAE EE tabularray ] <tblr>2 18]+ o & Eo|Zlc}.

\begin{tblr}{
colspec={Q[l]Q[clQ[r]Q[4cm, 1]},
hline{1,Z}={.8pt}, hline{2}={.6pt},
vline{3}={.4pt},
vline{3}={4}{dashed}
}
\SetRow{font=\bfseries, fg=olive5} Left & Center & Right & 4cm \\
row 1, col 1 & row 1, col 2 & row 1, col 3 & row 1, col 4\\
— \cline{l1-2}
row 2, col 1 & row 2, col 2 & row 2, col 3 & row 2, col 4\\

TABLE 0| % 39



\cline[dashed]{1-2}\
\SetCell[c=2]{bg=gra
— row 3, col 4\\ \
row 4, col 1 & row 4

row 5, col 1 & row 5,
row 5, col 1 & row 5,

rline[dashed] {4}

y!30,c} spanning two columns & row 3,
cline[dashed]{1-2}\cline{3}

, col 2 & row 4, col 3 & \SetCell{r} right\\
col 2 & row 5, col 3 & left \\

col 2 & row 5, col 3 & \SetCell{c} centre\\

col 3 &

\end{tblr}
Left Center Right 4cm
rowl,coll rowl,col2 | rowl,col3 row1,col4
row 2,coll  row2,col2 | row2,col3 row 2, col4
| spanning two columns | row 3, col 4
row4,coll rowd,col2 | row4, col3 right
row 5,coll  row5,col2 | row5,col3 left
row 5,coll row5,col2 | row 5, col 3 centre

tabular7} U5 Z o] 4] gt H|o]#] ¢tof

o]-&sto] of 2] m|o|X|of] Ax|=
7| A& <sideways>2h=

E017kA] ¢k+= w7t 1tk longtable 3712 &
tabular £ 2H/gdst= Zlo] gt 74| Wi o|tt. gHH rotating

HE Al Fst=dl o] & o|-&5HH tabular A (= cell 5t

ENZ2Z =AY 2,501 A Zbzuk= A A2 £ 9ok,

tabularx 7] A= Eo] LH| 2 T AHZE0 2 AT £ X AY

A JLOHQ%PO:] FiARl dol2 || AU Fg 4 |

e

th&-2 of|Alo] .

A A AFE o] &5t

\begin{sideways}
\begin{tabularx}{7.5cm}{|1|X]
= X[}

\hline

\textbf{normal} &

— \textbf{tilted} &
\textbf{wider}\\

\hline

normal & \rotatebox{30}%
{I'm tilted!} & 13
I'm wider\\ 55
\hline +
\end{tabularx} ~
\end{sideways} g

§

wider
I'm wider

\
&

©

S

normal

JEtol| & longtable, supertabular, xtab 22 83t 17| X &
3 QoA M-S 222 colortbl T 7] A]

ol 9lct.

40
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Colour by row:\\\vskip 2mm

\begin{tabular}{lcr} Colour by row:
\rowcolor{cyan}
one & two & three\\
\rowcolor{green} one two three
one & two & three\\ _
\rowcolor{yellow}
one & two & three\\ one two three
\end{tabular}

Colour by column:\\\vskip 2mm

\begin{tabular}
{>{\columncolor{cyan}}1
>{\color{red}
\columncolor{green}}c
>{\columncolor{yellow}}r}
one & two & three\\ one three
one & two & three\\ one three
one & two & three\\

\end{tabular}

Colour by column:

one three

6.1 Table[>Line Spacing(&2] 3 7+3)

r°l'

Hlo] o] 8 7+A-L BlAE o] o|of wrxolA] ZHHT}, g o] A|ZHEE7] Hof 719l
P27 & F2] SohH L2 (length) 7F opt o] L A F £0] (height) & 2H= Ho|A] gh A
il

\rule-2 18] E2o] 9it}, & o]0 7hA S Fajw \\ol| 4 A2 Zo] 2 ) H3ict,

o3 ol & B4t

\begin{tabular}{1l11}

one & two & three\\

0.3 centimeters & one two three

< \textbf{after} & 0.3 centimeters after this line
this line\\[0.3cm]

one & two & three\\ one two three

one & two & three\\ one two three

\rule{Opt}{1l.2cm}1.2

— centimeters &
\textbf{before} & this
— line\\

\end{tabular}

1.2 centimeters before this line

6.2 Table[>Aligning Numbers($x] J3)

X

tabular 1% W SHF 2A 2 o] 248 ANF 71 E 02 GHshol T ui}
ek,

Vg 412 e @ AW ANAE o183t Zoltk. SATe TP Yt oAl
Al & i), 2 elat &t 2402 v

6.1 TABLEI>LINE SPACING(HE 2| &l 7HA)
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begin{tabular}{r@{.}1
\3&24129\\ Hretat 3.14159
18661803\\ 1.61803
18&41421\\ 1.41421
et
3, deolumn 3714 & ©] 85+ D B A AR F7h2 £ 4 QA Hid, o] A4
A Al 7o) AAHE ZHeTh 22 BEX 220 718 457, 2202 Uehts 257
(252 5 th.olth, 2T 244 okl (2.8%) AHslsolth A A A7H2 A (doy
02 7Rolol YRS L4 A% AL} DEE AUAE UEPA 4 Uk T}
o] Zto] —1ojH AP Y& e £4HE 7|F0 g 7o AP Uehd),
o] sf71Al= EJ RE Qo] BT 435 mraly 7Estn R A Fo HAE U

£ o= \mbox ¢t

Ju

ol
=
[¢]
-
&
(3]
o]

3\ mbox CH4l amsmath 2| \textZ £
o]

\begin{tabular}{D{.}{,}{4.2}%
D{.}{.}{53D{.}{.}{-1}}

\toprule

\mbox{One} & \mbox{Two} &

\mbox{Three}\\

10.33 & 10.33 & 10.33\\

1000 & 1000 & 1000\\

5.1 & 5.1 & 5.1\\

3.14 & 3.14159 & 3.14159\\

\bottomrule

\end{tabular}

One
10,33
1000
5,1
3,14

Two
10.33
1000
5.1
3.14159

Three
10.33
1000
5.1
3.14159

6.3 diagbox(e] tjz+d)

diagbox 37| X|+= \diagbhox ¥

g AgHTE>

\begin{tabular}{|l|1|1]|}
\toprule
\diagbox{Lesson}{Date}

- &
Monday & Tuesday\\
\midrule

Date
Lesson

Monday | Tuesday

Stratigraphy & room A
— & room A\\
Chemistry & room B &
— Lab $\alpha$\\
Physics & room C & Lab

Stratigraphy
Chemistry
Physics

room A
Lab o
Lab é

room A
room B

room C

—  $\deltas$\\
\bottomrule
\end{tabular}

(55759 of| & 0f| slashbox TH7 | X| 2 EHA4 5t
2ALY T2 E 2|50 diagbox I 7| XK=
slashbox 2| & 74X FFof| CHet X[ @2 st
QICH 322 2 LO{Tl slashboxE AtOICHE
oot gich
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https://www.ctan.org/pkg/dcolumn
https://www.ctan.org/pkg/diagbox

6.4 BIEX E A7)

£2]5] Dol Al tabular] W& st 2= 22 AZ-2 Lol ohdls| A|ZHH o=
THE tabular W-8-& BIEX ZE2 APl = YAFe| EZL QL.

&2‘1

« https://www.tablesgenerator.com/
o https://www.latex-tables.com/
« https://tableconvert.com/latex-generator

o https://products.aspose.app/tex/latex-table-generator

6.5 KIEX HIo|EZ Hlo]g] 7}x27]

Y dFE sk ol & Zosi. dHole fd2 thRE
& ASCH THY Y wj = JA|TH AT EAE §FAlo] 7]

sttt 7o o] AN EAE X 802 ASCI H|o]A9] ,csy T ZHHO 2 K
l:l

U718k 2ol 7hs ), 28 1R § & she 2] o (97wl 2421 2% 2 0| 220 Ol TAB
- 1= L E2ALE 7 |EF 2R ME X2 (csvete
dlole] o o] W82 BIEX & P4 o= HEsto] dots A2 AL dolth. of g1zo) ojnjei= 2a)) Alﬁwt(i Cix|
1o i — o 5 ASHR| b=, T 0|R= 2 ZHlol Mo
A7fsHe T2IARE Unix § sh £3FELIY dlofe] 5 gJole] Ay ol shio] JHMIBEM, J0IRE EE B0l
BIEX T EZ HEsitt. | csv mhdol] tisiA = §2te ol a2 olc,

#!/bin/sh
# dat2tex.sh: converts tabular data to a tabular environment
if [ $# != 1 ]; then

echo "Usage: $0 <datafile>"

exit 1

fi

# is this a csv file?

grep ";" $1 > /dev/null
if [ $?2 = 0 ]; then
AWK="awk -F;"
else
AWK=awk
fi

# ok awk, make my day
$AWK '{if (1 == FNR) { \
printf "\\begin{tabular}{"; \
for (i = 1; i <= NF; i++) {printf "1"}; \
printf "}\n"
)
for (i = 1; i < NF; i++) \
{printf $i" & "} printf $NF"\\\\ \n"} \
END {printf "\\end{tabular}\n"}' $1

# end of dat2tex
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https://www.tablesgenerator.com/
https://www.latex-tables.com/
https://tableconvert.com/latex-generator
https://products.aspose.app/tex/latex-table-generator

7  Tools Hl%

7.1 Tools[>Mail Merges(H ¥ #])

o] F-&stal AIZtS Aekst| sl S 7152 textmerg T 7] A A5t
8o EAoA o] 23 A, SHTS v o] = 7HES H5 AZts| EAE. 1 o] Q]9
g2 A3}t

B ol A Pekx| e BB sl Al /o] HE (feld)S A 2|8 Zlolch. Z+zk \Name,
\Surname, \Titleo|2}al 5}#}. o] d|Gsh= gk 9% 19l data.dat ZHE 714
2t}

\documentclass{article}
\usepackage{textmerg}
\begin{document}

% let's declare the variable fields:
% \Void is for empty lines
\Fields{\Name\Surname\Title-\Void}
\Merge{data.dat}{%

Dear \Title{} \Surname,\\

may I call you \Name?\\

Yours,\\
\hspace{3cm}Guido\clearpage}
\end{document}

U] MR ZEol \Voidi AA| W3 AL ol o] A= 9J5}e] Tt} 1 oo
atolq A 7127} £of Lt o] A2 Hlof g apdolA Hlof 9l& 4 A& UERdT 7t
glise] FE2 W =& i}

data.dat 3] Y-&2 o|5 Ao g &|o] it}

Guido
Gonzato
Dr.

Francesco
Mulargia
Prof.

Marie
Curie
Mme

7.2 Tools[>Labels(2H2 ZA)

WY W] 7F L oh 2kl ghE 7= of 7hesteh 3x 8 AE|F 2kl 8-2] 9o Fd s 2k 20
e gHeEtha S B}, ARSE w 7] 2], A &SHAITE labelsghe Zlojth, Thg of| Alofl A
1070 1 g2k 2 1070+ gt
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https://www.ctan.org/pkg/textmerg
https://www.ctan.org/pkg/labels

\documentclass[adpaper,12pt]{article}

\usepackage{labels}
\LabelCols=3 % n. of columns of labels
\LabelRows=8 % n. of rows of labels

\LeftBorder=8mm % borders of each label

\RightBorder=8mm

\TopBorder=5mm

\BottomBorder=5mm

\LabelGridtrue % show the grid

\numberoflabels=10 % number of labels of each type to print

% the text of the label is specified by

% the \addresslabel[]{} macro:

\begin{document}
\addresslabel[\large] % optional arguments
{\textbf{Guido Gonzato}, Ph.D.\\
\textsl{GNU/Linux Sysadmin}}
% now on to the boxed labels
\boxedaddresslabel[\fboxsep=4mm\fboxrule=1mm]
{\textbf{Guido Gonzato}, Ph.D.\\
\textsl{GNU/Linux Sysadmin}}

\end{document}

2palo] 2 THE 245 TEGHES Astew olke] £4% dlog HYmuE 7

F42 2052 37U el shedo] F45 #ojdofof & Ao},

\documentclass[adpaper,12pt]{article}
\usepackage{labels}
\LabelCols=3
\LabelRows=8
\LeftBorder=3mm
\RightBorder=3mm
\TopBorder=8mm
\BottomBorder=8mm
\LabelGridtrue
\begin{document}
% use either this environment:
\begin{labels}

1$~{st}$ name

1$~{st}$ address

1$~{st}$ city, state, zipcode

2$7{nd}$ name
2$"~{nd}$ address
2$~{nd}$ city, state, zipcode

3$7{rd}$ name
3$”{rd}$ address
3$7~{rd}$ city, state, zipcode
\end{labels}
% or an external file containing exactly the same text:
% \labelfile{addresses.dat}
\end{document}

7.2 TOOLS[>LABELS(2H& =t4)



textmerg®t labels & Z23oto] &-85t= AT Al s 2 7] Higttt,

7.3 Tools[>Default Language(t}=ro])

BIEX 2] 7|2 doj&= Fojoltt. 22|y thE doj = 2|3ttt of 7|4 ddof 2| o|zt 3t
‘chapter’t} ‘index’ @} 22 8015 Zt=rofo] 87| /Adst= A, SHHE stol =yl d 4],
a3 gy et 2 FIAES JIHERRE(EEE \c cH Vet o] st A)
JGdh= A5S 9ngich

KIpX vz holl = language . dat 2= 2 o] ($TEXMF/tex/generic/config/language.

dat) ZgHElo] Qlit] o 7)ol 2} )lof B2 o] Qlrt. o] udS W Ste] ¢! ARG B 97 o) Mg ALg X mESte of EiCk,
SOl 20 Fhg] 0 210{ GOJE| TFU2 TeX Live 7} A4J5tH=
StolE 2 & 7HAl= ol g e 4 ek 20192 1 A6 1042 RAI{0f0F St
o] AL 2 [} oj|g} 7+o] AR AFXI7FO| THUS HES 4 QIths AN
g o] AR§27} ok 2t babel T 7] A & T ol 2t Zo] ARg-gtt. ] & Qlo SRt Fo| = molrt AExt
4750] A 210] MEHS babelO|Lt 210f X|&!

\usepackage[italian,english]{babel} I§7|X| £ 0|85t A0t

ESS  babel® U 2A12 FABHE olojo] AEehA vkt 97t ek, vk B}
A @O 2 Lk GH=TH \charkx 4] 0 2 Qe s ),

EIF RO ES ZAY AR RUIE ZAHE 23 W o4 E 7 UTF-8 & olsliste 5
sfoF & " g7} ek, 1211 2018 ] oll= inputenc®} fontenc T 7| X7} E 2 3iT},

\usepackage[utf8]{inputenc}
\usepackage[T1]{fontenc}

2018\ o], KIEX 9| 7]& £} 1792 UTF-80] | ct.

o] £

o] 2 A7t F71ett. ol & E R A= ZAE AASte WY 2EL2 koTX
7] 2] () & ©l-&5t= Zoltt. pdflatex, xelatex, lualatex ZF 110 thsto] Sh= {22
LS AlFokaL 32 FA = FAG

\usepackage{kotex}

koTgX §lol = a3 EAIsh= A2 2417t glek. theFst qlzlof| oiske] thafst 1y
Nrelo] Ut ol & X pdflatex©lX19] cjk-ko, xelatexollA12] polyglossia 5°] ‘,21_131],
53] lualatex S0l 4] babel 27| 2] 9] AHE- 7Hs A = &obA 7haL QU

7.4 Tools>Hyphenation(5}c] = d|o] )
A 2 BIEX o] ©o] o] o] =ujo] & & 2] 2]k Ho| ATt mj 2 £~21Q] © 2 o] & 2] g]
Sk Zlo] Qs 4 Qlth, 4214 sto| =& YA Zatd £

O L2 WO 2 Shol & 1€ thgat 2ol Ml A b5k,

\hyphenation{ge-o-phy-sics ge-o-lo-gy earth}
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https://www.ctan.org/pkg/babel

99] Bho] & 72 412l o Alo] ©J3HH ‘earth’BHe Toji ofClolA = Bo] = ]| A]
1 k. ol o] 57 Sols} #1o| H2}=12] Q1 S12I 1 Hol \mbox 2ol =,

Do not hyphen \mbox{internationalisation}, please. I'm a
— masochistic man.

7.5 Tools>Spell Check(Z=} ZA})

BTEX M= " 2ol tfsl] &2 25ty "2} AAMS 34 S ispell, aspell 22 2]5 S0
oJafloF gtr}, 2 Unix Al AEIOIA ispell S th-&-} Zo] AFR-S 4= U},

shell> ispell -t mydocument.tex

-t 29120 ispellol A ToX 2 BX W RAISET @45 Zole). vt gopst
olg}H -d A9 x| 2 HATF Aof AP S A A sl|S0foF T},

shell> ispell -d italiano -t mydocument.tex

8 Help "+

22RQ1rf @ makel S 9hESh KIEX ERE2 A+ B2 Wiio] ot e Wzl Hotof
Sk X2 CTAN Afo]Eolt}, https://www.ctan.org/tex-archive/info/.
« Unix Al 2] B3P0l A info latex FH-S W™ BIEX BT 7igol tisto
kel AR 289 A S Agat
« https://www.ctan.org/tex-archive/info/LatexHelpBook/ EIEXol thst
0% £53t =32 A Windowsoll tigh &&= 2 &0 Qlct,
. https://groups.google.com/group/comp.text.tex/topics #A1ES A
Foix ok 4 Gtk 7% £82 9 e 4 e AN ol

o] EX 2 W3lxH, tE o] GNU/Linux Wl ZZHoj A Az g 4> 9= kA X/

BIEX AAEIRI TeX Liveol] £0f o}, 4o £%& FAE A&ttt 12| Ubuntu
71419 /usr/share/doc/texlive-doc/ t2lE]g] olgjo| A EAE 23 4 Ut o
Uo7} texdoc B2 435 F&ottt. ol & S0, fancyvrb I 7| FA4& AW oFF

geS Ut
shell> texdoc fancyvrb

9 mhxE

o] 4= ® Guido Gonzato©l] 2|5} Zlu|d| ZE 2 A &5 GNU A5 &A] glo] AR
HjZ 3t} o] 7to] =7t =2-0] B 7] & vHight}, of Aty I E gt Zxloj| Al HuUjETh
H oj9- 7] & Zlo|o},

7.5 TOOLS[>SPELL CHECK(EX} ZA})
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https://www.ctan.org/tex-archive/info/
https://www.ctan.org/tex-archive/info/LatexHelpBook/
https://groups.google.com/group/comp.text.tex/topics

22 A BN WS

article 222 9] ’IE32 2,180 H3it}. ol o B2 oA & HF

=

s},

\documentclass[twoside, 11pt]{book}
\begin{document}

\frontmatter

\begin{titlepage}

\title{The Book of Mine}
\end{titlepage}

\author{John B. Smith}
\maketitle

\tableofcontents

\mainmatter

\part{The Beginning}
\chapter{Introduction}
\section{Let's Start}

The book starts here.

\part{The End}

\backmatter

Thank you for reading this book.
\end{document}

1% A.1: Book template

\documentclass[twoside,12pt]{report}
% tables and figures at the end:
\usepackage{endfloat}
\begin{document}

\title{Final Report}
\author{John B. Smith}
\date{London, \today}
\maketitle

\begin{abstract}

This is the final report.
\end{abstract}

\tableofcontents

\listoftables

\listoffigures

\part{Start}

\chapter{Begin}
\section{Introduction}

The report starts here.
\end{document}

17 A.2: Report template
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\documentclass[12pt]{letter}
\begin{document}

\address{My address}
\signature{Guido}




\begin{letter}{John's address}
\opening{Dear John,}

Thank you for being my friend.
\closing{Hope to see you soon,}
\ps{P.S. Say hello to granny!}
\encl{My son's photographs!}
\end{letter}

\end{document}

1% A.3: Letter template

\documentclass[adpaper]{article}

\usepackage{typelcm}

\usepackage{times}

\usepackage{color}

\usepackage{rotating}

\pagestyle{empty}

\begin{document}

\begin{sidewaysfigure}
\fontsize{2.5cm}{2.5cm}\selectfont
\centerline{\textcolor{blue}{\textbf{Please:}}}
\vskip 1lcm
\fontsize{4cm}{3cm}\selectfont
\centerline{\textcolor{red}{D0O NOT}}
\centerline{\textcolor{red}{SMOKE}}
\centerline{\textcolor{red}{HERE!'}}

\vskip 1lcm
\fontsize{2cm}{2cm}\selectfont
\centerline{\textcolor{magenta}{If you do,}}
\centerline{\textcolor{magenta}{you'll be \emph{deboned!}}}
\end{sidewaysfigure}
\end{document}

13 A.4: How to write a notice

\documentclass{article}

\usepackage[absolute, showboxes]{textpos}
\usepackage{color}

\usepackage{framed}

\usepackage{graphicx}
\setlength{\TPHorizModule}{10mm} % standard unit of length
\setlength{\TPVertModule}{\TPHorizModule}
\setlength{\TPboxrulesize}{1lpt} % box line width
% start everything near the top-left corner
\textblockorigin{®mm}{Omm}

\thispagestyle{empty} % no page number

\begin{document}
\setlength{\parindent}{Opt}
\definecolor{shadecolor}{rgb}{0.9,1,1}
\begin{textblock}{5}(0,0)
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% this block is 5 modules wide; height is
% automatically determined
\begin{center}
\begin{minipage}[c]{0.8 \linewidth}
\begin{shaded}
This block is placed with its top left corner at the “origin'
on the page, which has been set to (Omm,0mm). The internal
margin and the shading are provided by the \texttt{minipage}
and \texttt{shaded} environments.
\end{shaded}
\end{minipage}
\end{center}
\end{textblock}
\begin{textblock}{6}(10,1)
\includegraphics[width=6cm,angle=-90]{gnuplot.pdf}
This picture is at (10,1). Note that rotating it
by -90 makes it overflow the margin.
\end{textblock}
\begin{textblock}{5}[0.5,0.5]1(2.5,8)
This block is at position (2.5,8), but because the optional
argument [0.5,0.5] has been given, it is the centre of the block
which is located at that point, rather than the top-left corner.
\end{textblock}
\begin{textblock}{3,4}(6,4)
The dimensions of this block are 3$\times$4 cm.
Its origin is position (6,4) on the page. Note that the text
overflows the margin in some cases; you'll want to
use the \texttt{minipage} environment to prevent that.
\end{textblock}
\end{document}

1% A.5: How to write a poster

B2 B 32 Markdown Pandoc oA

(o] W& o217 Z7hekedeh) 2.4700 4] 27433 Y Pandoc W3] S o] §5He

down A5 RF=2 2dste MEE AlSotth sig Ao MES &1 Aot
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title: |
=S 7|0l H=Cf: \
HEE & & 0|4 S W
author: Guido Gonzato
date: 20184 1g¥
documentclass: oblivoir
papersize: b5paper
fontsize: 1lpt
classoption: gremph
numbersections: true
header-includes: |
\usepackage{fapapersize}
\usefapapersize{*,*,30mm,50mm,25mm, *}




\ifLuaOrXeTeX
\setkomainfont(Noto Serif CJK KR) (* Bold) (Noto Sans CJK KR Light)
\fi
abstract: |
29%FS 7|0 Ho{&2}.

<i--- AMEL O/ WHOE HojgZ -->

# M4 8
2248 *+BE 2T 4 ULt
#7129 (italic)* 2= 7H58tH| 820 of

Alfst=5 2YsloF stot. O7|M= LHHE

HYSHAUCH. Yot HAEE 1Y 22 MY

(]
35 93 AOB [OfXT 4 M] (#theend) 2
# NEMAE 3o
‘verbatim text'E MEE £ QLC}.
# OFR|SH MM {#theend}
OFHR| A M ZEStA|I 7| E:
> 0|, pandocO| O] HHLIE[ZR] QFUCHL!
2|9 2|2 pandocO| UZA|.

<!l--- end of pandoc_ template ko.md -->

2 S AE oblivoirZ 3H T HEL article =417} ¥t} header-includes
H-2olA oblivoirg 913t A7 o] Eof o B & thE wA] SejAet o] 25 sl S
20| R 5 L5k A U A gt

Pandoc S Z pdf ¥gste]H oh5 Hid& W=,

shell> pandoc --toc --pdf-engine=xelatex \

pandoc_template ko.md -o pandoc_ template ko.pdf

--pdf-engines xelatex 22 A HsFRlT}. o] ALX]7} §lo™ pdflatex 2= Hutd
gt

YAML header2] numbersections: += Ao HS & Holgl= Zlolth, HH3Y A
OF --number-sections AAE Fol& 22 AiE A&t} Pandoc?] 7|23k AlA

HS 5 AA|5= Aol
ok TOC7F E 251t Pandoc A3 M M O2 - -tocstH &3t

51



	도입
	사전 지식
	예제 보이기에 관하여
	에디터가 지원하는 기능
	패키지 추가하기
	Info 페이지 추가

	문서 작성의 황금률

	File 메뉴
	File▷New(새 파일)
	File▷Save As…(다른 형식으로 저장)
	File▷Save As Template(템플릿으로 저장)
	File▷Import(들여오기)
	File▷Page Setup(페이지 설정)
	Page Setup▷Headers and Footers(상하단 면주)

	File▷Print Preview(출력 미리보기)
	File▷Print(인쇄)
	File▷Versions(버전 관리)

	Edit 메뉴
	Edit▷Autotext(자동완성)

	Insert 메뉴
	Insert▷Breaks(행자름)
	Insert▷Enumerated List(번호부 나열문단)
	Insert▷Special Character(특수문자)
	유로화 기호(AC)

	Insert▷Formula(수학식)
	SymPy 사용법
	Insert▷Footnote(각주)
	Footnotes and Endnotes(각주와 미주)

	Insert▷Indices(목차)
	Insert▷Vertical and Horizontal Space(수평 수직 간격)
	Insert▷Tabs(탭)
	Insert▷Cross Reference(교차참조)
	Insert▷Margin Notes(여백문단)
	Insert▷Text Frame(프레임)
	Insert▷Image(이미지)
	Insert▷Figure(삽도)
	문단을 파고드는 그림

	Insert▷Shapes(도형)
	Insert▷Page(페이지)
	Insert▷Rule(괘선)
	Insert▷Hyperlink(하이퍼링크)
	Insert▷Comment(주석)

	Format 메뉴
	Format▷Line Spacing(행 간격)
	Format▷Character(글자 모양)
	화학반응식의 첨자
	밑줄 긋기
	Format▷Character Size(큰 글자)
	Format▷Character Font(폰트)
	Format▷Character Colour(글자 색상)
	Format▷Character Outline(윤곽선 글자)

	Format▷Paragraph(문단 모양)
	Paragraph▷Horizontal Alignment(정렬)
	Paragraph▷Vertical Alignment(문단 사이의 정렬)
	Paragraph▷Margins(문단 폭)
	Paragraph▷Indentation (들여쓰기)
	Paragraph▷Border and Shade(프레임과 음영)
	Paragraph▷Colour(문단 색상)
	Format▷Columns(다단)


	Table 메뉴
	Table▷Line Spacing(표의 행 간격)
	Table▷Aligning Numbers(수치 정렬)
	diagbox(셀의 대각선)
	LaTeX 표 생성기
	LaTeX 테이블로 데이터 가져오기

	Tools 메뉴
	Tools▷Mail Merges(메일 머지)
	Tools▷Labels(라벨 작성)
	Tools▷Default Language(다국어)
	Tools▷Hyphenation(하이프네이션)
	Tools▷Spell Check(철자 검사)

	Help 메뉴
	마치는 말
	문서 템플릿
	한글 Markdown과 Pandoc 예제

